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Notice 
OMRON products are manufactured for use according to proper procedures by a qualified operator and only for 
the purposes described in this manual. 

The following conventions are used to indicate and classify precautions in this manual. Always heed the 
information provided in them. Failure to heed precautions can result in injury to people or damage to the 
product. 

DANGER  Indicates an imminently hazardous situation which, if not avoided, will result in death 
or serious injury. Additionally, there may be severe property damage. 

WARNING  Indicates a potentially hazardous situation which, if not avoided, could result in death 
or serious injury. Additionally, there may be severe property damage. 

Caution Indicates a potentially hazardous situation which, if not avoided, may result in minor 
or moderate injury, or property damage. 

 

OMRON Product References 
All OMRON products are capitalised in this manual. The word “Unit” is also capitalised when it refers to an 
OMRON product, regardless of whether or not it appears in the proper name of the product. 

The abbreviation “PLC” means Programmable Logic Controller and is not used as an abbreviation for anything 
else. 

 

 



OMRON PART 3: CX-Server Runtime - User Manual 

Revision 2.4 CX-Server Runtime_Page (ii) 

Visual Aids 
The following headings appear in the left column of the manual to help you locate different types of 
information. 

Indicates information of particular interest for efficient and convenient operation of the product. 

1, 2, 3… Indicates lists of one sort or another, such as procedures, checklists etc. 

 Represents a shortcut on the Toolbar to one of the options available on the menu of the same 
window. 

Other manual conventions are as follows: 

•  Windows-based applications provide users with a number of different ways to perform one operation. These are 
normally: from the application menu bar; using icons on a Toolbar; using keyboard shortcuts; using the right-mouse 
button to display a context-sensitive menu; dragging and dropping. Whilst recognising this, the manual provides user 
instructions employing the Toolbar and right-mouse button only. Use of the application menu bar or keyboard 
shortcuts are only included if no such alternatives exist. 

•  Access to the CX-Server middleware is normally via other software applications, such as CX-Programmer or 
CX-Protocol. This is noted in the manual by the term “invoking application”. 

•  This manual refers to two distinct types of project: CX-Server projects and application projects. A CX-Server project 
is defined in this manual. An application project is defined by the software application invoking CX-Server. 

 OMRON, 2005 
All rights reserved. No part of this publication may be reproduced, stored in a retrieval system, or transmitted, in 
any form, or by any means, mechanical, electronic, photocopying, recording, or otherwise, without the prior 
written permission of OMRON. 

All copyright and trademarks acknowledged. 

No patent liability is assumed with respect to the use of the information contained herein. Moreover, because 
OMRON is constantly striving to improve its high-quality products, the information contained in this manual is 
subject to change without notice. Every precaution has been taken in the preparation of this manual. 
Nevertheless, OMRON assumes no responsibility for errors or omissions. Neither is any liability assumed for 
damages resulting from the use of the information contained in this publication. 
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About this Manual 
This manual describes the CX-Server application and its ability to control and monitor a range of OMRON 
PLCs. It does not provide detailed information concerning the PLCs themselves, for this information the 
commercial manual for the device must be consulted. 

This manual contains the following chapters: 

•  Chapter 1 - Technical Specification. This chapter describes CX-Server in general terms and introduces the user to 
the relationship between CX-Server and associated products. It also provides details of the operating environment, 
minimum configuration and installation procedures necessary for the satisfactory operation of CX-Server. 

•  Chapter 2 - Introduction to CX-Server. This chapter describes the concepts on which CX-Server is based including 
the definition of PLCs, points and groups. 

•  Chapter 3 - Communications. This chapter describes the communications supported by CX-Server 

•  Chapter 4 - Import/Export Tool. This chapter describes the Import/Export Tool and its ability to add data from 
CVSS and LSS files to a CX-Server project. 

•  Chapter 5 - DDE Manager Tool. This chapter describes the DDE Manager and its ability to read and update point 
data via CX-Server. 

•  Chapter 6 - Performance Monitor Tool. This chapter describes the Performance Monitor Tool and the procedures 
involved when monitoring communications. 

•  Chapter 7 – Driver Management Tool. This chapter describes the Driver Management Tool and how to manage 
your device drivers within CX-Server. 

•  Appendix - A Network Availability. The tables in this appendix indicate the network available to each PLC device 
group. FinsGateway has no network availability and is not described. 

•  Appendix B - PLC Memory Area. The tables in this appendix provide memory area details for each device group. 

•  Appendix C - Toolbars and Keyboard Shortcuts. The tables in this appendix summarise the toolbars and keyboard 
shortcuts available from each component tool. 

A Glossary of Terms and Index are also provided 
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CHAPTER 1 
Technical Specification 

This chapter describes the CX-Server software in general terms and introduces the user to the relationship 
between CX-Server and associated products. It also provides details of the operating environment, minimum 
configuration and installation procedures necessary for the satisfactory operation of CX-Server. 

CX-Server Software 
CX-Server is a communications management system in Microsoft Windows for OMRON PLCs. It provides 
facilities to maintain PLC device and address information and to communicate with OMRON PLCs and their 
supported network types. 

CX-Server consists of the following components: 

As well as acting as a server for other OMRON software, CX-Server includes other customer tools: 
♦  CX-Server DDE Manager tool. A tool for allowing transference of data between PLCs and a client using 

DDE, for example Microsoft Excel. 
♦  CX-Server Import tool. This tool is used for addresses and PLCs defined using the CVSS and LSS 

products. It allows definitions of addresses and PLCs to be used by importing them into a CX-Server 
project file. 

♦  CX-Server Performance Monitor tool. A tool for monitoring communications throughput and for 
displaying CX-Server’s current performance level (i.e. a check to see if CX-Server is becoming 
overloaded). 

♦  CX-Server Driver Manager tool. A tool for installing and un-installing new software drivers for support 
of hardware devices. 

CX-Server operates on IBM compatible personal computers with Pentium or better central processors, including 
Pentium II. It runs in a Microsoft Windows environment (Microsoft Windows 95, 98, Millennium, 2000 or XP 
and NT4.0 with Service Pack 5 or later). 

CX-Server comprises various executables, Dynamic Link Libraries (DLLs) and components. In order to use 
certain communication types (i.e. Ethernet, SYSMAC LINK, SYSMAC NET), some settings must be 
configured prior to use – separate to the software installation. Refer to Chapter 3- Communications for further 
details. 

About this Manual 
This User Manual acts as a reference for CX-Server by describing its various concepts and abilities. It also 
provides the basics of using its dialogs and supplied utilities. 

Caution This manual is referred to from other software that utilises CX-Server, for instance, 
CX-Programmer, CX-Protocol, CX-Supervisor or CX-Server OPC and CX-Server 
Lite. Subsequently, some topics contained in this user manual may not be relevant. 

CX-Server comes with a context-sensitive online help system which is designed to complement this manual and 
to provide a quick reference at any point while using CX-Server when the manual is not to hand. This general 
help system uses a fast hypertext system, which allows progressively detailed information about any topic to be 
obtained by selecting keywords within the descriptive text. 

Throughout this manual it is assumed that the reader has a working knowledge of Microsoft Windows and know 
how to: 

♦  use the keyboard and mouse; 
♦  select options from Microsoft Windows menus; 
♦  operate dialog boxes; 
♦  locate, open and save data files; 
♦  edit, cut and paste text; 
♦  use the Microsoft Windows desktop environment. 
If the installed version of Microsoft Windows has not been used before, it is recommended that the reader 
spends some time working with it using the Microsoft documentation before using CX-Server. 
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Features 
CX-Server is the corner stone of the suite of applications collectively known as the CX-Automation Suite. The 
CX-Automation Suite is not one system but software that has been designed to dynamically evolve with every 
direction a manufacturer would like to take and to accommodate any implementation, improvement, adaptation 
or extension of any form of control or data acquisition in a manufacturing industry. 

The software suite has been developed to serve you with powerful yet comprehensible software that builds and 
runs networks that simply control one machine or an entire manufacturing process. It comprises the following: 

♦  CX-Programmer 
♦  CX-Server Lite 
♦  CX-Server OPC 
♦  CX-Protocol 
♦  CX-Motion 
♦  CX-Supervisor 

The CX-Automation suite is in itself highly adaptive. It completes the integration of process control and 
business information systems, by applying one and the same basic network architecture. For the user it means 
that data from both sources of information can be jointly reported in familiar applications such as spreadsheets, 
in which they can be recalculated in existing layouts or processed along usual spreadsheet procedures. 

The architecture is based on standards that are widely maintained such as ActiveX and OPC (OLE for Process 
Control) and standard interfaces such as COM, DCOM and ODBC/ADO This conformity also means that you 
can use standard interfaces and standard software. 

System Requirements 
CX-Server operates IBM PC-AT compatible or NEC PC-98 compatible computers with Pentium II class or 
better. central processor. It runs in a Microsoft Windows environment (Microsoft Windows 95, 98, Millennium, 
2000 or XP and NT4.0 with Service Pack 5 or later). 

Note: CX-Server is not guaranteed to be compatible with computers running Windows emulation 
(for example, Apple Macintosh). 

The following configurations are the minimum system requirements for running CX-Server in Microsoft 
Windows 95, 98, Millennium, 2000 or XP and NT4.0 (with Service Pack 5 or later). Internet Explorer version 
5.0 or higher is required. Windows 200, ME and XP already have suitable versions of Internet Explorer. For 
users of older operating systems, Internet Explorer version 5.5 is available on the CD-ROM. 

 
Minimum System Requirements 

 
Minimum Specification Recommended Minimum Specification  

Operating 
System 

CPU 
Type 

Memory 
(RAM) 

HDD 
Space 

Display CPU 
Type 

Memory
(RAM) 

HDD 
Space 

Display 

Windows 95 
Windows 98 
Windows NT 
(with SP 5) 

Pentium 
Class 

133 MHz 

32 Mb 100 Mb 800x600 
SVGA 

Pentium 
Class  

200 MHz 

64 Mb 150 Mb 1024x768 
SVGA 

Windows 
2000 

Windows ME 

Pentium 
Class 

150 MHz 

64 Mb 100 Mb 800x600 
SVGA 

Pentium 
Class  

200 MHz 

64 Mb 150 Mb 1024x768 
SVGA 

Windows XP 
Home 

Windows XP 
Professional 

Pentium 
Class 

300 MHz 

128 Mb 100 Mb 800x600 
SVGA 

Pentium 
Class  

600 MHz 

256 Mb 150 Mb 1024x768 
SVGA 

 

Use of a mouse is highly recommended, although all operations can be performed using the keyboard. Refer to 
Appendix C for a list of keyboard shortcut commands. 
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The amount of RAM and hard disk space used depends upon the size of the PLC programs written – 
approximately 1K per step. 

Communications Requirements 
In order to use serial communication types SYSMAC WAY and Toolbus the following is required: 

♦  RS232 connection via a standard serial port on the PC (COM1 etc.) or RS422 connection to a 422 serial 
board. 

♦  In order to use SYSMAC LINK directly from the PC a SYSMAC LINK Network Service Board and 
FinsGateway Version 3 or higher is required. 

♦  In order to use SYSMAC NET directly from the PC a SYSMAC NET Network Service Board and 
FinsGateway Version 3 are required. (Windows NT4 only) 

♦  In order to use Controller Link directly from the PC a Controller Link Network Service Board (wired or 
optical) and FinsGateway Version 3 or higher are required. 

♦  In order to use Ethernet an Ethernet card, Windows Sockets software and TCP/IP must be installed and 
configured. 

♦  In order to use an ISA board FinsGateway Version 3 or higher is required. 
♦  Controller link PC NSB is supported using FinsGateway Version 3 or higher. 
♦  SYSMAC LINK PC NSB is supported using FinsGateway Version 3 or higher. 
In order to use FINSGateway with the CLK/SLK PCI board in the Windows 98 or 2000 operating system the 
appropriate drivers must be installed. These drivers can be found on the CX-Server CD under:  CX-
Server\WDM\CLK (PCI)\  or  CX-Server\WDM\SLK (PIC)\ 

Refer to Chapter 3- Communications for more information and the appropriate hardware system manuals for 
full information about connecting and configuring these devices for the environment. 

Installation 
This describes the procedures involved in the installation of CX-Server on a standard workstation running 
Microsoft Windows 95, 98, Millennium, 2000 or XP and NT4.0 with Service Pack 5 or later. 

The software is supplied on CD-ROM and is installed easily from within Microsoft Windows. The installation 
can be terminated at any point during the installation process. 

If CX-Server is being installed as part of the CX-Programmer installation then on completion of the CX-
Programmer installation a number of dialogs will prompt for information concerning the installation of CX-
Server and its components. 

Note: Internet Explorer 5.0 or higher is required for the correct operation of CX-Server. Users of 
Windows 95, 98 or NT may have an earlier version of Internet Explorer installed. If the 
installer does not find a suitable version of Internet Explorer, it will prompt you to 
automatically install Internet Explorer 5.5 from the CD-ROM. 

1, 2, 3… 1. Insert the CD-ROM in the appropriate drive and select the Run option from the Start 
pushbutton on the taskbar. 

 2. Click the Browse pushbutton and select the Setup.exe executable file in the CX-Server 
directory or from the CD-ROM drive. 

 3. Click the OK pushbutton to start the installation then follow the on-screen instructions. 

Starting CX-Server 
CX-Server components are normally accessed from the invoking application. However, a number of tools can 
be accessed as stand-alone tools from the windows Start menu (on the Microsoft Windows taskbar). 

 
Performance Monitor tool. 

 
DDE Manager tool. 

 
CX-Server Import / Export tool. 
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Help and How to Access it 
 CX-Server comes with a detailed context-sensitive help system. At any time while using the software, it is 
possible to get help on the particular point that is currently being worked on, or on general aspects of CX-
Server. This system is intended to complement the manual, by providing online reference to specific functions 
of the software and how to use them. The manual is designed to provide more tutorial information and discuss 
the various facilities offered by CX-Server. 

♦  Context-sensitive help;  
♦  Help Index (available on the Help menu); 
♦  Help Contents (available on the Help menu); 
♦  About (available on the Help menu); 
♦  Status Bar tool button tips. 

Help Topics 
Select the Help Contents option on the Help menu. The Help system provides a standard look-up dialog under 
the Contents tab showing the contents of the CX-Server Help file. Click on an item to read the associated 
information. 

Index 
Use the following procedure to retrieve online help from the Index tab of the Help Topics dialog. 

1, 2, 3… 1. Select the Help Index option from the Help menu. 
 2. Enter a text query into the first step field. The second step field is refreshed according to 

the query entered in the first step field. 
 3. Select an entry in the second step field and select the Display pushbutton, or double-click 

on the index entry. 
 4. If an entry is linked to two or more topics, the names of the topics are displayed in the 

Topics Found dialog. Select a topic and choose the Display pushbutton or double-click 
on the topic. 

Find 
Use the following procedure to retrieve on-line help from the Find tab of the Help Topics dialog. 

1, 2, 3… 1. Select the Help Index option from the Help menu. 
 2. Select the Find tab. 
 3. Enter a text query into the first step field. The second step field is refreshed according to 

the query entered in the first step field. Previous text queries can be retrieved by selecting 
from the drop-down list in the first step field. 

 4. Select a word that matches the query – some words may be automatically selected. More 
than one word can be selected by pressing Shift and selecting another word to extend the 
selection, or by pressing Ctrl and selecting another word to add to the selection. The third 
step field is refreshed according to the word or words selected. The number of topics 
found are shown at the bottom of the dialog. 

 5. Select a topic from the third step field and select the Display pushbutton, or double-click 
on the topic from the third step field. Select the Clear pushbutton to restart the find 
operation. 

The Find operation can be enhanced by the use of the Options pushbutton and Rebuild push-button. Refer to 
Microsoft Windows 95 documentation for further information. 

Context-sensitive Help 
CX-Server supports the use of context-sensitive help. The relevant online help topic is provided automatically 
by selecting the current area of the display responsible for carrying out those actions. Select the F1 function key 
to retrieve context-sensitive help. Some dialogs include a Help pushbutton when F1 cannot be accessed. 
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About CX-Server 
Each CX-Server component contains an About option on the Help menu. The About CX-Server dialog supplies 
technical reference information about that component such as version and copyright information. It also contains 
the version number which is required for obtaining technical support. 

Use the following procedure to view the About CX-Server dialog. 

1, 2, 3… 
 

1. Select About from the Help menu. 
2. The About box is displayed. It provides a copyright statement and version number of the 

component or tool within CX-Server. 

Status Bar 
The Status Bar is displayed at the bottom of many of the CX-Server component and tool windows. It provides 
several helpful pieces of information while programming: 

 

♦  Instant Help. A brief message appears in the Status Bar as menu commands and buttons are selected. 
♦  Online Status. The online or offline status of the PLC. 
♦  PLC Mode. When connected to a PLC, this shows the current PLC mode. Connection errors are also 

displayed here. 
♦  Connected PLC and CPU Type. The currently connected PLC and associated CPU can always be 

referenced in the status bar. 
The CX-Server Status Bar can be enabled and disabled from many components and tools by selecting the Status 
Bar option from the View menu. 

Technical Support 
If the installation instructions for this have been followed (refer to ‘Installation’ above), no difficulties should be 
encountered. However, if there is a problem, contact Customer Services. 

If a problem occurs, check that it does not relate to a fault outside CX-Server. Check the following: 

♦  The PC is working correctly. 
♦  The PLC is working correctly. 
♦  The communications system is set up correctly. 
♦  The errors are cleared in the PLC. 
When Customer Services need to be contacted, keep the details shown in the following table to hand. A clear 
and concise description of the problem is required, together with the exact text of any error messages. 

Note: Use the About box to obtain the version number of the component. 
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Customer Services Required Information Table 

Version number of CX-Server 
component or tool: 

 

Serial number of the software:  
Operating system and version 
number: 

 

Language of operating system:  
PLC type, model and CPU 
details: 

 

Type of communications in use:  
Serial  
Toolbus  
SYSMAC LINK  
SYSMAC NET  
Device NET  
Controller Link  
Ethernet  
Nature of the problem:  

Steps taken to reproduce 
problem: 

 

Other comments:  
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CHAPTER 2 
Introduction to CX-Server Projects 

This chapter describes how data is identified within CX-Server projects (in terms of PLCs, points and groups). It 
also describes the CX-Server functions available for the purposes of configuring PLCs and points within a CX-
Server project. 

CX-Server Projects 
CX-Server is a middleware package which allows other software to access OMRON automation devices (PLCs, 
temperature controllers, Memory Card Writer and PROM Writer) through various connection types. In order to 
co-ordinate these communications, it handles information detailing the PLC devices attached to the PC and the 
information being accessed on each device. 
Such information is held in a CX-Server project file with a .CDM extension. This file contains all of the 
information about the PLCs, which CX-Server can connect to and the addresses of interest in each PLC which 
may be accessed. 
Each CX-Server project file is separate and is similar in concept to a document. CX-Server can deal with many 
CX-Server project files at a time, although often only one CX-Server project is used by the client software at 
any time. 
A number of steps are involved in the setting up of a CX-Server project. At a high-level, these can be regarded 
as: 
♦  Identifying the PLCs which the PC is to communicate with; 
♦  Identifying the addresses (points) within the PLC which are to be accessed during communications; 
♦  Establish the type of network to be used. 

CX-Server Project Concepts 
CX-Server projects consist of PLCs, Connected Devices, Networks and Points. The following paragraphs 
describe the of PLCs, Networks and Points into a CX-Server project and introduce the Project Editor. Specific 
setup of PLCs and Networks are described in Chapter 3 - Communications. 

PLCs 
A CX-Server project file contains a list of PLCs which are (potentially) connected to the PC. These PLCs do not 
really have to be connected unless communications with them are to occur. 
Each PLC has the following attributes: 
♦  Device Name. A unique name with the CX-Server project file so that the PLC can be easily referenced (for 

example, ‘PumpRoom1’). 
♦  Comment. A free-form long comment which is only used for information by the user that is attached to the 

unique device name. 
♦  Device Type. The PLC device type (for example, CV500). 
♦  Connection Type. How to connect to the PLC and the address of the PLC on the chosen network (for 

example, direct one-to-one connection or via a gateway PLC, one that is already defined in the CX-Server 
project). 

♦  Type Options. A list of options which may be present on the PLC (for example, the amount of user-
memory, clock, EM configuration and CPU type). 

♦  Connection Options. A list of options which may be available on the chosen network (for example, the 
speed of communication on SYSMAC WAY, Toolbus, Modem configuration, or Network or Node 
configuration details). 

A full description of the communications possibilities for C-series PLCs, CV-series PLCs and CS/CJ/CP-series 
PLCs is provided in Chapter 3 - Communications. Host Link Port and Peripheral Port settings are made via the 
PLC Setup Component, refer to PLC Tools User Manual Chapter 4 - PLC Setup Component. Once the network 
has been defined and configured, it can be tested to ensure that messages are being transmitted correctly. 

The PLCs selected also affect which other setup procedures need to be performed; for example, the CV-series 
and CS/CJ/CP-series requires setting up the IO Table and using the PLC Setup Component to establish specific 
PLC characteristics. In addition it is possible to set up to three levels of networks and to communicate with these 
networks, the initial, direct connection must be to a PLC acting as a gateway. To ensure that messages from the 
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PC reach the end connection PLC, the gateway PLC must contain the routing information which identifies this 
PLC. Procedures for configuration of the network is provided in the Chapter 8 CX-Server Network 
Configuration Tool, Chapter 10 Data Links, Chapter 11 Routing Tables in the PLC Tools User Manual. 
Connection to the PLC requires the specification of the type of communications interface to be used to connect 
to the PLC. CX-Server supports two methods of communication: serial communications and network 
communications. Serial and network communications can be made using the Connection Type dialog although 
these are dependent upon the type of PLC being communicated with. 

Points 
The CX-Server project file also contains a list of addresses which may be accessed in the defined PLCs, each 
address being contained inside a point. Each point has the following attributes: 

♦  Name. A unique label within its group so that the point can be easily referenced, similar to folders in 
Microsoft Windows Explorer (for example, ‘Conveyor Position’). 

♦  Comment. A free-form long comment used only for reference by the user. 
♦  Address. The location of the information inside the configured PLC: 

♦  including the PLC (by name, matching the label of the defined PLC), 
♦  address (for example, ‘D0’), 
♦  the number of elements (for example, ten elements for ten channels) and type (for example, bit, 

channel, floating point). 
Points are stored within the CX-Server project file in a hierarchical group structure. New groups may be added 
to the CX-Server project at any level of the hierarchy tree. Groups act as container objects (as folders contain 
files) for relevant points within a CX-Server project. Similar points may be banded together and stored within 
these groups. 

Editing a CX-Server Project PLC List  
The Edit Project dialog allows the PLC or Points information in the currently opened CX-Server project to be 
modified, deleted or added. A CX-Server Project PLC list can be edited from either the Import/Export tool or 
the CX-Net tool by selecting the appropriate .cdm file and then selecting Edit from the Project menu. 
Alternatively from the Project Editor right click on Devices and select the Properties option or select Properties 
from the File menu. 

Alternatively from the Project Editor right click on Devices and select the Properties option or select Properties 
from the File menu. 

Click on the PLCs Setup pushbutton in the edit project dialog to edit the CX-Server project PLC list. 

The Device List dialog is subsequently displayed; this is the central point for adding and setting up PLCs and 
lists all currently defined PLCs in the open CX-Server project file, their type, network details and any comments 
associated with each device. 
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 This icon denotes a PLC. 

 This icon denotes a PLC also used as a gateway PLC. 

 
This icon denotes that the device is open for communications. A device list cannot be opened 
whilst open for communications. 

 
A PLC device cannot be deleted or have its network or device settings altered if it is open for 
communication (i.e. active). It cannot be modified in any way if the CX-Server project has 
been opened as read-only. It cannot be deleted or its device type changed if it is acting as a 
gateway. 

Adding a PLC 
The Device List dialog also permits addition of new PLCs to the open CX-Server project. Use the following 
procedure to add a PLC. 

1, 2, 3… 1. Click on the Add pushbutton in the Device List dialog. An entry is made in the list of 
Configured Devices. 

 2. Enter a name in the PLC Name field. This has a maximum length of 32 characters and 
must be unique within the currently open CX-Server project file; it must not contain any 
of the following characters: : / \ : ; , ? * & ! “ but can contain spaces and international 
characters. The PLC Name field is case sensitive, i.e. if a name is entered in upper case 
which already exists in lower case (and vice versa), a new PLC is created. 

 3. Select options for the Device field and Network field for the new PLC. The list of 
Configured Devices is updated. Clicking outside this new entry results in a confirmation 
dialog being displayed. If required select the associated Settings pushbutton to refine the 
Device Type Settings and Network Settings. Refer to Chapter 3 - Communications for 
further information. 

 4. If the Close pushbutton or another PLC name is selected, a dialog appears asking for 
confirmation of the changes just performed; select the Yes pushbutton to remove the 
dialog and save the new PLC. Select the Cancel pushbutton to abort the operation. 

Note: The default device name selected from the Add pushbutton in the Device List dialog 
is unique within the CX-Server project, for instance ‘NewPLC1’. 

Deleting a PLC 
The Device List dialog also permits deletion of a PLC from an open CX-Server project. Use the following 
procedure to remove a PLC. 

1, 2, 3… 1. Highlight the required PLC name in the Device List dialog and select the Delete button. 
A dialog is displayed asking for confirmation of the deletion. 
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 2. Select the Yes pushbutton to confirm the deletion or the No pushbutton to cancel the 
operation. 

 
It is not possible to delete a device that is open for communications, indicated by the Device 
Open icon, as it cannot be opened. 

 It is not possible to delete a device being used as a gateway device, indicated by the Gateway 
Device icon. 

Renaming a PLC 
The Device List dialog allows the name of a PLC to be altered. Use the following procedure to rename a PLC. 

1, 2, 3… 1. Highlight the required PLC name in the Device List dialog and click on the Rename 
pushbutton. 

 2. Type in the new name, to a maximum length of 32 characters. 
If the Close pushbutton or another PLC name be selected, a dialog appears asking for confirmation of the 
changes just performed; select the Yes pushbutton to remove the dialog and save the new name. Select the 
Cancel pushbutton to abort the operation. 

Editing CX-Server Project 
Points and groups within a CX-Server project can be edited via the CX-Server Project Editor which is accessed 
from the Import/Export tool or the DDE Manager. The Project Editor allows new points, groups and devices to 
be added, modified to and/or deleted from the CX-Server project.  

A CX-Server Project can be edited by selecting Edit from the Project option on the menu bar of the Import / 
Export tool or by opening / editing a project in the DDE Manager. The option is not available to all tools and 
components and is further unavailable unless a CX-Server project has been opened or created. 

Click on the Points Setup pushbutton in the edit project dialog to edit the CX-Server project. The information 
displayed includes the following: 

 
A ‘devices’ view showing all devices configured in the CX-Server project and each device 
available memory areas. The complete group hierarchy of the CX-Server project, and details 
of the points (in their memory areas) within the CX-Server project. 

 
A ‘points’ view showing details of the points (within their groups). 

Comments (name and address comments) relating to a point are displayed when the appropriate element is 
highlighted. 

A point represents an input or output data area within a PLC; it can refer to a single bit of data (representing for 
example, “Hopper empty”, “Activate Reject Solenoid”), or to a multiple bit word (representing for example, 
“Process Temperature”). 

Associated with each point is a name and address indicating its position within a PLC and a PLCs memory; 
comments can also be entered against a point’s name and address. 

The information held at a point can be read or updated by CX-Server. A third party can also access this point 
data by establishing a link between that and the PLC. 

Note: More than one point can have the same address, any comment entered against this 
address applies to all points at this location. Comments entered against the point name 
are unique to that point only. Points do not have to have a name, however, if a name is 
supplied it must be unique. 

To access the Project Editor, open the CX-Server Import/Export tool and open or create a project. Then from the 
Project menu select Edit, this opens the Edit Project dialog. In Edit Project click the Points: Setup button. 
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The status bar provides instant help. 

The Project Editor can be manipulated in a similar manner to Microsoft Windows Explorer. The left pane 
displays the content of the project in terms of Devices Networks and Points. The right pane provides detailed 
information on the selected item, such as Name, Type and Address etc. 

 To expand the hierarchy in the left pane, select this icon. 

 To collapse the hierarchy in the left pane, select this icon. 

To view the content of a particular branch in the hierarchy, double-click on the item in the left pane. 

 
Select the Up One Level button from the toolbar to traverse back through the hierarchy 
toward the root. 

 
Select the Large Icons button from the toolbar to display the content of the right pane as large 
icons. 

 
Select the Small Icons button from the toolbar to display the content of the right pane as small 
icons. 

 
Select the List button from the toolbar to display the content of the right pane as a list. 

 
Select the Details button from the toolbar to display the content of the right pane with 
associated details. 

The Toolbar and status bar can both be turned on or off. Select Status Bar from the View menu to control the 
display of the status bar. Select Toolbar from the View menu to control the display of the Project Editor toolbar. 

If points are displayed in the right pane, the view can further be modified by setting certain preferences. 

♦  Showing invalid points; 
♦  Showing open points / PLCs; 
♦  Automatic resizing of list column. 
Use the following procedure to set point preferences. 

1, 2, 3… 1. Click on the Points icon in the left pane to open the points view of the editor in the right 
pane. 

 2. Select Options from the View menu. The options dialog is displayed. 
 3. Amend point preferences from the General tab. Select the OK pushbutton to complete 

the operation. Select the Cancel pushbutton to abort the operation. 
For moving, resizing, maximising, minimising and closing windows, refer to Microsoft Windows online help. 

 To save changes and close the Project Editor, select the Close button in the title bar. 
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Adding a Group 
Points are saved within groups in a CX-Server project. When a CX-Server project is initially created it contains 
the root level group only. Groups can be created within a CX-Server project in hierarchical order from the root 
level. Points are saved within the root group or specified subsidiary groups within the hierarchy, similar to 
folders and files within the Microsoft Windows Explorer. 

The Add Group dialog adds a new group under the currently selected group. 

1, 2, 3… 1. Open the Project Editor, click on the branch of the CX-Server project hierarchy to which 
the group is to be added; for instance the Points root branch and add a group. 

 
2. Select the Add Group button from the toolbar. The New Group ‘n’ will be added to the 

tree structure in the appropriate position. 

Renaming a Group 

 
To rename a group, select the group followed by the Rename button in the toolbar. 
Alternatively select Rename from the File menu option. or right click on the group and select 
the Rename option. 
The new group name has a maximum length of 32 characters and must be unique within the 
group that it is being created. It must not contain any of the following characters: / \ : ; , ? * & 
! . “. 
The group name field is case sensitive. For example, if a name is entered in upper case which 
already exists in lower case a new group name will be allowed. 

Adding a Point 
The Add Point dialog allows a new point within the currently open CX-Server project to be created and its name 
and address to be entered. Use the following procedure to add a point. 

1, 2, 3… 1. Open the Project Editor, click on the Points branch in the tree. 

 
2. Select the Add Point button from the toolbar. The Add Point dialog is displayed. 

 3. Select the Logical Tab and enter the new name in the Name field; this has a maximum 
length of 32 characters, it must be unique, and must not contain any of the following 
characters: / \ : ; , ? * & ! “ but can include an existing path to indicate the group to which 
it belongs (if it is to be added to a group other than that indicated above the name). A 
name is optional, but if supplied must be unique. 

 4. A comment can only be added to a point if a point name has been supplied. Enter text in 
the Comment field to be associated with the point name. This field is optional and is used 
simply for reference purposes.  

 5. Select the Physical Tab and select the PLC to be associated with the point in the PLC 
field. This field is mandatory but can be set to ‘None’ until a correctly configured PLC is 
added to the CX-Server project. 

 6. Enter the data location in the Data Location field identifying the area of memory to 
which this address applies; this value is dependent upon the type and configuration of the 
PLC and is mandatory if a PLC has been selected. Memory Area and Start Address must 
be supplied, for instance, ‘D0’ for a CV-series and CS/CJ/CP-series PLC or ‘DM0’ for a 
C-series PLC. Refer to Appendix B PLC Memory Areas for a complete list of valid PLC 
memory areas and ranges. 

 7. Enter the number of elements indicating the number of address units which start at the 
specified data location (i.e. the size of an array of addresses, for instance, ten for ten 
channels) in the Elements field. This field defaults to 1. 

 8. Select the Internal Data Type in the Internal Data Type field, identifying the format of 
the data held at the PLC address (e.g. BCD or binary, WORD or double WORD). This 
allows CX-Server to automatically convert the PLC specific format of the data to a 
common format which the PC can use. 

 9. Select the Command Modifier required to access this address in the Command Modifier 
field. The modifiers available depend upon the data location chosen. An example of a 
modifier is Forced Set which forces a data location to be held with given data, overriding 
the PLC program's usage. 
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 10. Select the OK pushbutton to save the point details or the Cancel pushbutton to discard 
the new point. 

Note: The fields in the Address chapter of the dialog are only enabled when a PLC has been 
selected and the values available in these fields (if any) also depend upon the PLC 
chosen. 

If several points are to be added at a time, the Leave Box setting should be checked, this allows the dialog to stay 
active after the Add pushbutton is pressed. The fields remain populated with the previous point’s settings 
allowing further modification. Select the Close pushbutton to remove the dialog. 

A point can have a name and/or an address. It does not need to have both. 

Points with valid addresses assigned are marked by an icon according to the Internal Data Type set as follows: 

Internal Data Type Icon  Internal Data Type Icon 

No type defined  
 Single Word Unsigned BCD  

Bit  
 Double Word Unsigned BCD  

Signed Character Binary  
 Quad Word Unsigned BCD  

Unsigned Character Binary  
 Single Word Signed BCD  

Raw Character Binary  
 Double Word Signed BCD  

Single Word Unsigned Binary  
 Quad Word Signed BCD  

Double Word Unsigned Binary  
 Double Word Float  

Quad Word Unsigned Binary  
 IEEE Float  

Single Word Signed Binary  
 Complex  

Double Word Signed Binary  
 LReal  

Quad Word Signed Binary  
   

Points with an invalid PLC address assigned to them are indicated by the associated icon. 

Editing a Point 
The Edit Point dialog displays the current configuration for a selected point allowing these details (including the 
name) to be amended. The Edit Point dialog operates in the same manner as the Add Point dialog described 
above. 

1, 2, 3… 1. Select the point to be edited. 

 
2. Select the Properties button from the toolbar. The Edit Point dialog is displayed. This is 

identical to the Add Point dialog. 

 
A point's address or PLC cannot be modified if it is currently active, i.e. open for 
communications, indicated by the Device Open icon in the Project Editor. 

Deleting a Point or Group 
Use the following procedure to delete a point or a group. 

1, 2, 3… 1. Highlight the point or group to be deleted. 

 
2. Select the Delete button from the toolbar to delete the point or group. 

A confirmation dialog is displayed provided this option has been set in the Options dialog. 

 
Any points or groups contained within a group being deleted are also removed, unless any 
points within the group or children of the group are open for communications, in which case 
the points and the groups they are contained within are not deleted. 

Points which are currently active cannot be deleted. 

Note: The root group cannot be deleted. 

Moving and Copying Points and Groups  
The Project Editor allows standard Microsoft Windows drag and drop procedures permitting points and groups 
to be copied or moved within the Points group. 
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Moving is achieved by clicking on an item and then dragging the mouse to the item’s new position. A 
confirmation dialog is displayed. Copying is similar except that the Ctrl key must be kept depressed. 

Use the following procedure to copy or move information from or in the Project Editor. 

1, 2, 3… 1. Select an item in the right pane of the Project Editor, for example a point. More than one 
item can be selected by pressing Shift and selecting another item to extend the selection, 
or by pressing Ctrl and selecting another item to add to the selection. 

 
2. Select the Copy button from the toolbar to copy the item, or the Cut button from the 

toolbar to move the item. 
 3. Select an area in the Project Editor to copy or move the items to, for instance copying a 

point into a new group. 

 
4. Select the Paste button from the toolbar to paste the item. A Paste operation can be 

performed several times without copying again. 

Adding a Device 
The Project Editor also permits devices to be added into the CX-Server project as an alternative to the Device 
List (refer to Chapter 2 - Adding a PLC for details). Use the following procedure to add a device. 

1, 2, 3… 1. Open the Project Editor, click on the Devices branch in the tree. 

 
2. Select the Add PLC button from the toolbar. The Change PLC dialog is displayed. Refer 

to Chapter 3 - Communications for details regarding device setup. 
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CHAPTER 3 
Communications 

This chapter describes the communications options available to CX-Server and is confined to software aspects 
and the associated CX-Server interface; more detailed information relating to each hardware product is to be 
found in its associated OMRON commercial manual. 

Supported Communications 
Communications between CX-Server and target PLC’s are achieved by a combination of different network 
connection types. SYSMAC WAY, SYSMAC LINK, SYSMAC NET, Controller Link, Toolbus, Ethernet, 
Memory Card Writer, PROM Writer, Modem and Device Net. Each network connection has different 
capabilities. SYSMAC NET is specially suited for medium to large scale systems where connecting PLCs to 
computers is included. SYSMAC LINK provides the necessary capabilities of an industrial network: SYSMAC 
WAY operates at a much simpler level, its primary functions are for monitoring and diagnostics. SYSMAC 
WAY and Toolbus both provide Modem connection facilities. 
The combination employed depends upon the requirements of the system. The network connection types used 
will determine the maximum speed of data transfer rates and frame lengths that can be used. When the PLC 
network is first set, the default connection should be used to determine the maximum frame length and baud 
rates. 
CX-Server controls communications with target PLCs, formats messages into the correct protocol and then 
transmits them to the device (normally a PLC but it can be a memory card); messages are also received from the 
PLC containing data to be transmitted to applications, for example CX-Programmer, CX-Protocol and CX-Net 
Network Configuration tool. The type of messages transmitted include requests to update point data or to 
download programs. 
When a PLC is being configured, as discussed in Chapter 2 - Introduction to CX-Server Projects, CX-Server 
automatically provides a list of the possible network types associated with the selected device; PLC Tools User 
Manual Chapter 8 - CX-Net Network Configuration Tool describes how to create the actual PLC/network 
communications links (including the creation and modification of associated Routing and Data Link Tables). 

Device Setup 

PLC Settings 
Each CX-Server project can contain a list of devices. A device can be a PLC which can be configured to map on 
to a physical connection (either directly or via an existing gateway connection). A correctly configured 
connection allows connections to the PLC. 
Each device added to the CX-Server project must be given a unique name within the CX-Server project file; the 
device type and network connection should also be given, for example: ‘CV500’, ‘SYSMAC WAY’. 

The Change PLC dialog allows a new PLC to be added to the CX-Server project and its device type and network 
settings to be defined. It is also used to edit existing PLC details. It is accessed from the invoking application or 
from CX-Server CX-Net tool. It can also be accessed from the Project editor by expanding the device list, 
selecting the appropriate PLC and then clicking the properties button in the toolbar or selecting Properties from 
the File menu. 

Note: A PLC cannot be created unless a CX-Server project has been opened. Whilst PLCs 
are added to the CX-Server project via this dialog, the CX-Net Network 
Configuration Tool must be used to set up routing tables for those PLCs acting as a 
gateway. Refer to the PLC Tools User Manual Chapter 8 - CX-Net Network 
Configuration Tool for further information. 
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Use the following procedure to change the PLC settings: 

1, 2, 3… 1. Enter a name in the Device Name field. A device name must consist of no more than 32 
characters and must be unique. 

 2. Select the device type of the PLC in the Device Type field. If the device requirement does 
not appear in the list then CX-Server does not support it. 

 3. Further configure the device type (e.g. CPU number) by selecting the Device Type 
Settings pushbutton. Refer to Chapter 3 - Device Type Settings for further details. 

 4. Select the network type of the PLC in the Network Type field. This list may include other 
PLCs in the CX-Server project that can be used as gateway devices, depending upon the 
device type chosen. A full list of connection types are provided below. 

 5. Further configure the network settings (e.g. node number) if applicable by selecting the 
Network Type Settings pushbutton. Refer to Chapter 3 - Network Communications (End 
Connection) for further details. 

 6. Optionally, enter a comment relating to this unique PLC in the Comment field. 
 7. Select the OK pushbutton to save the new PLC or the Cancel pushbutton to abort the 

operation. 

Note: The Device Name must not contain any of the following characters: / \ : ; , ? * & ! . “ 
but may include spaces and international characters. The Device Name is case 
sensitive, i.e. if a name is entered in upper case which already exists in lower case, a 
new PLC is created. The contents of the Network field depend upon the device type 
settings of the new PLC. The Device Type Settings pushbutton is disabled for the 
following devices: C20, FinsGateway, Memory Card Writer and Programmable Read 
Only Memory (PROM) Writer, since these devices do not have options. Any PLCs 
which have been set up and can act as a gateway device appear in the Device Type 
field. 

A full list of connection methods is as follows:  

♦  SYSMAC WAY. 
♦  Toolbus. Toolbus on the CS/CJ/CP-series PLCs allows CX-Server auto-baud rate detection up to 115,200 

bps. Toolbus on the CS/CJ/CP-series PLCs supports full n clients and n destinations. 
♦  When the PLC model is set as a CP1H CPU Unit equipped with a USB port, a computer’s USB port can be 

connected directly to the PLC’s built-in USB port with a standard USB cable. 
♦  Modem via SYSMAC WAY. Modem is supported through SYSMAC WAY communications via Windows 

TAPI configuration. 
♦  Modem via Toolbus. Modem is supported through Toolbus communications via Windows TAPI 

configuration. 
♦  Ethernet via TCP/IP. Ethernet is only supported for CS/CJ/CP-series PLCs, CV-series PLCs and 

C200HE/G/X/E-Z/G-Z/X-Z series PLCs. All Ethernet connections now also support full n clients and n 
destinations via CX-Server Ethernet driver. CX-Server also utilises FinsGateway Version 3 Ethernet driver 
if the required PLC connection UDP port is locked open by FinsGateway active running services. 
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♦  Controller Link for OMRON NSB. Controller Link is supported through FinsGateway Version 3 when 
installed via CX-Server installation and services are activated. CS-series PLC Optical Controller Link is 
supported via FinsGateway Version 3 when Controller Link is installed. 

♦  SYSMAC LINK for OMRON NSB. SYSMAC LINK is supported through FinsGateway Version 3 when 
installed via CX-Server installation and services are activated. 

♦  SYSMAC NET for OMRON NSB. SYSMAC NET communications are supported on Windows NT only 
through FinsGateway Version 3 when installed via CX-Server installation and services are activated. 

♦  FinsGateway CPU unit connection and Gateway connection combinations. 
♦  DeviceNet The unit for Device Net Communications is available for all CS1/CJ1 series PLCs and the 

CPM2*-S* PLCs. 
♦  CS1 Board for OMRON CS1 PCI board. PCI Board is supported through FinsGateway version 3.12 when 

installed via CX-Server installation and services are activated. 

Device Type Settings 
The Device Type Settings dialog allows further configuration of the selected PLC. This is important since the 
behavior of the PLC depends upon details such as CPU type (e.g. the network options available to a C200HS 
require CPU31 or CPU33 setting to be specified). Device type settings cannot be adjusted for an open PLC or a 
gateway PLC. 

The General tab of the Device Type Settings dialog allows: 

♦  Selection of CPU Type; 
♦  Allocation of Program Memory or protection from writing; 
♦  Allocation of Expansion Memory or protection from writing; 
♦  Allocation of File Memory or protection from writing; 
♦  Installation of a Timer/Clock. 

 
When settings cannot be selected, the PLC is fitted with the standard settings as shown on the Device Type 
Settings dialog and cannot be reconfigured. Similarly, if Expansion Memory cannot be selected for CV-Series 
PLCs, EM memory cannot be configured. 

In each instance, availability of CPU Type and memory depends upon the device type selected (and also the 
amount of expansion memory purchased for the PLC). Changing CPU type automatically changes the amount of 
memory available on some devices. 

For SRM1 PLCs, only CPU Type can be selected. 

For CV-series PLCs, CS-series PLCs and IDSC, File Memory allows selection of the amount of EPROM or 
EEPROM. A Timer/Clock can be installed. 
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Defining Connections and Gateway PLCs 
It is possible to communicate with PLCs which are not directly connected to the computer via PLC network 
configuration and gateway abilities of PLCs. Generally, a directly connected PLC or the network NSB as a 
gateway is used to route to the required PLC by use of its routing table and networking capability. In order to 
specify the link information, a network type (e.g. SYSMAC LINK) and PLC addressing information is needed 
(i.e. target network, node and unit). 

Connection can be directly made to any PLC type. Direct connections are established with SYSMAC WAY, 
Toolbus, Modem, Ethernet through a network card or SYSMAC NET, Controller Link or SYSMAC LINK via 
an OMRON NSB. 

It is also possible to gateway from a direct connection on to another type of network that cannot be connected to 
directly. 

 
Use the following procedure to define a gateway connection. 

1, 2, 3… 1. Open the Change PLC dialog. 
 2. Select the Gateway PLC (i.e. the direct connection). If necessary configure the CPU type 

by selecting the associated Settings pushbutton. 
 3. Select the Network type and click on the associated Settings pushbutton. The above 

example uses Ethernet as the network. 
 4. The Network Settings dialog is displayed. Set up the address and Node number. For 

Ethernet, also enter the IP address. 
 5. Select the OK pushbutton to proceed from the Network Settings dialog. 
 6. Select the OK pushbutton to proceed from the Change PLC dialog. 

Use the following procedure to define a target connection. 

1, 2, 3… 1. Add a PLC Device to the CX-Server project. The Change PLC dialog is reopened. Select 
the PLC type for the target PLC. If necessary configure the CPU type by selecting the 
associated Settings pushbutton. 

 2. Select the PLC to be used as the Gateway PLC from the list in the Network Type field and 
click on the Settings pushbutton. 

 3. The Network Settings dialog is displayed. Set up the Source Network and Destination 
Network and Node number. 

 4. Select the OK pushbutton to proceed from the Network Settings dialog. 
 5. Select the OK pushbutton from the Change PLC dialog to complete the operation or the 

Cancel pushbutton to abort the operation. 

Serial Communications (Direct Connection) 
The computer involved in establishing communications has at least one serial (RS232) port; the first port is 
normally called COM1. If in doubt check the configuration of your PC. Only a single PLC can be connected to 
an RS232 port. 

For CS/CJ/CP-series PLCs, if Toolbus is being used as the direct connection, multiple destinations are 
permitted. 

To establish a serial connection to several PLCs, Link Adapters are required that convert from RS232 to RS422. 
Link Adapters would be connected in the serial line between the computer and the PLC or between the remote 
Modem and the PLC. Multiple connections are permitted from an RS422 port.  

If problems are experienced when making a serial connection, check the serial port on the computer is enabled 
and that a mouse driver is not loaded or connected to the same port. 

For PLCs with direct serial connections on the CPU, default communications settings can also be set by 
changing the DIP switches on the front of the CPU. The default protocol settings are 9,600 baud, 7 data bits, 
even parity and 2 stop bits. Older PLCs have a default baud rate of 2,400. For PLCs not supporting this feature, 
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settings are configured via the PLC Setup component. Refer to the PLC Tools User Manual Chapter 4 - PLC 
Setup Component for details of the PLC Setup component. 

SYSMAC WAY 
SYSMAC WAY provides a simple means of connecting a computer to a PLC for monitoring and diagnostic 
purposes. It has a slower transmission path than SYSMAC LINK, SYSMAC NET, Controller Link or Ethernet. 

Communications are achieved by either: 

♦  Employing the RS232 serial communications interface for communicating with individual PLCs. 
♦  Employing the RS422 interface for communicating with multiple PLCs. 
The following connections are required: 

♦  RS232 connection via a standard serial port on the computer (COM1 etc.) 
or 

♦  RS422 connection to a 422 serial board. 
These connections can also be made via a Modem. Refer to standard Microsoft Windows documentation for 
details on Modem configuration and setup.  

The Driver tab of the Network Settings dialog allows the configuration information to be entered; this 
information ensures that data is transmitted correctly over the network.  

 
 

Use the following procedure to apply Network Settings. 

1, 2, 3… 1. Click on the associated Settings pushbutton in the Change PLC dialog. 
 2. In the Network tab, check the Unit No, usually 0 for connecting to a single PLC or the 

multi drop number for an RS422 connection. 
 3. In the Driver tab, check the port on the computer for connection to the PLC and enter it in 

the Port Name field. 
 4. Select the Baud Rate, Parity, Data Bits and Stop Bits from the drop-down lists available 

for the selected port. 
 5. For the Modem tab, refer to Microsoft Windows documentation. 
 6. Select the OK pushbutton to save these settings, or select the Cancel pushbutton to abort 

the operation. 

Note: For CS/CJ/CP-series PLCs, SYSMAC WAY dip switch five on the front panel must 
be set to ‘OFF’. 

Toolbus 
Toolbus operates in a similar manner to SYSMAC WAY. The connection is made to a PLC using its peripheral 
port. 
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The following connection is required: 

♦  RS232 connection via a standard serial port on the computer (COM1 etc.) using either CIF01 or CIF02 
cable. 

The Driver tab is similar to that belonging to SYSMAC WAY; however, for some PLCs fixed values are 
entered and these cannot be altered (see table below). The CS/CJ/CP-Series PLC Toolbus configuration ensures 
successful connection to the PLC every time, independently of the rate specified by the user provided the Auto 
Baud Rate Detection setting has been checked. 

PLC Fixed Data Bits Parity Stop Bits 

CS/CJ/CP Series Yes 8 None 1 

CV/CVM Series Yes 8 Odd 1 

C Series No  - - - - - - - - - 

CPM1/CPM1A - - - - - - - - - - - - 

SRM1/SRM1-V2 - - - - - - - - - - - - 

CPM”*/CPM2*-S* - - - - - - - - - - - - 

CQM1/CQM1H - - - - - - - - - - - - 
 

Serial Networks 
When connecting a computer to a serial network of PLCs, each PLC needs to be configured so that it has a 
different Unit number. The Unit number for C-series PLCs should be configured as follows: 

CPU-mounted Host Link unit: DIP switches on back of unit 

Rack-mounted Host Link unit: Rotary switches on front of unit 

Direct CPU RS232 port: Internal DM settings 

Direct CPU Peripheral port: Internal DM settings 

 

The Unit number for CV-series PLCs and CS/CJ-series PLCs should be configured as follows: 

Rack-mounted Host Link unit: Unit Setup dialog 

Direct CPU RS232 port: Host Link settings dialog 

Direct CPU Peripheral port: Fixed as Unit 0 

Remote SYSBUS/2 Peripheral port: Fixed as Unit 0 

Note: The unit number rotary switches on the top of CV-series SIO units are the unit 
number of that Special I/O Unit on that PLC rack and not the Unit number of the PLC 
on the serial network.  

 
Online connection is possible through a Serial Communications Board or Unit with unit version 1.2 
or later mounted to a PLC directly connected via the peripheral bus (Toolbus) or Host Link (or to a 
PLC on the network) to a PLC connected serially with Host Link FINS. 

 

Target PLC Host Link unit number

CX-Programmer Ver.5.0 or later 

Serial 
Gateway 

Set the relay PLC. 
(Select in the Change PLC Dialog Box.) 

Serial Communications Board/Unit with unit Ver.1.2 or later 
(Select SCU (Unit 0 to 15) in the UNIT field.) 

Network Type: 
Select [PLC2]. 

Serial Gateway function port (Select
port 1/2 in the PORT field according 
to the calculated address.) 

Select the Use SYSWAY with the port option in the Host Link 
(SYSWAY) settings. 

Host Link FINS 

Enter the Host Link unit number in the Host Link Unit Number field for
the target PLC in the Host Link (SYSWAY) settings. 

System Configuration Example 

Device Name: PLC1

Device Name: PLC2

 

1. Register the PLC to be connected serially (using Host Link FINS) in the project gateway (e.g., 
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PLC2). 

2. In the Change PLC Dialog Box of the target PLC (e.g., PLC1), select the relay PLC (gateway 
PLC) in the Network Type pull-down menu (e.g., [PLC2] (See note.)) and click the Settings 
Button to the right of the Network Type pulldown menu. 
Note The PLC name enclosed in square brackets (e.g., [PLC2]) indicates the gateway PLC.  
 
 
 
 
 
 

Select the relay PLC (e.g., [PLC2] )as 
the network type. 

 

3. The Network Settings Dialog Box will be displayed. Click the Guide for Serial Gateway 
Button. 

Click this button. 

 

4.  The Serial Gateway Guide Dialog Box will be displayed. Select the unit and the port number 
under the Calculate Address Area. 

 

The Serial Communications port 
address is automatically calculated. 

Select the Unit. 

Select the port. 

 
•  Select the Units from the UNIT pull-down menu as follows: 

CPU: CPU Unit (See note.) 
SCB: Serial Communications Board 
SCU (Unit 0 to 15): Serial Communications Unit numbers 0 to 15 
Note: The Host Link FINS Serial Gateway is not currently supported for the CPU Unit, so 
connection is not possible even if CPU is selected from the CX-Programmer. 

•  Select the port from the PORT pull-down menu in the as follows: 



CX-Server Runtime - User Manual  
CHAPTER 3 – Communications OMRON 
 
 

CX-Server Runtime Page 22 Revision 2.4 

CPU:Peripheral: CPU Unit’s peripheral port (See note.) 
CPU:COMM: CPU Unit’s built-in RS-232C port (See note.) 
SCB:Port1_/SCB:Port2_: Serial Communications Board’s port No. 1/2 
SCU:Port1_/SCU:Port2_: Serial Communications Unit’s port No. 1/2 
Note: The Host Link FINS Serial Gateway is not currently supported for the CPU Unit, so 
connection is not possible even if a CPU port is selected from the CX-Programmer.  

•  The serial port number address is automatically calculated in the Calculated Address field on the 
right. 

5. Select the Use SYSWAY with the port option in the Hostlink SYSWAY Setting field, and enter 
the actual Host Link unit number for the target (communications partner) PLC in the Host 
Link Unit Number field. 
•  When using the CX-Programmer, enter the actual Host Link unit number. Do not add 1 to 

the value. The CX-Programmer will automatically add 1 internally. 
 

Select this option. 

Enter the unit number for the actual Host Link
(values are incremented by 1 automatically).

 
6. Click the Apply Button. 

 

Network Communications (End Connection) 
Each network supports a protocol (or set of rules) determining the manner in which a message is transmitted. 
Requests sent are formatted into the relevant protocol with each message being validated and prioritised 
according to the rules associated with that protocol. 

Once a connection has been established between a device and CX-Server, a set of routing rules and tables are 
defined which organise the connection between these two processes. The manner of routing depends upon the 
protocol (identified with each network type) involved in communicating with the PLC. 

The Routing Tables are created via offline table editors but they can also be manipulated online using the CX-
Net Network Configuration tool. These tables, although they vary in format, contain the network, memory and 
node address information required to ensure that information is directed correctly across the relevant network. 
They also allow the connections to be defined for PLCs which are to act as gateways. Refer to the PLC Tools 
User Manual Chapter 8 - CX-Net Network Configuration Tool for further information. 

When employing SYSMAC LINK, Controller Link and SYSMAC NET networks, each PLC must be 
configured on each network to have different Node numbers. If two or more networks are joined together, 
Routing Tables must be created and each network given a unique Network number in order to establish 
communications between them. 

FinsGateway is also needed to establish Controller Link, SYSMAC LINK and SYSMAC Net on NT; refer to the 
FinsGateway Manual for further information. 

When the Routing Tables have been set up, communications are possible from all the computers to all PLCs. 
Although each network is given a specific number, the local network can always be addressed as network 0. If a 
serial connection has been made to a CV-series PLC, network 0 refers to the network that is connected to the 
lowest numbered Special I/O Unit and the local PLC can be addressed as Node 0. 
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Note: Remember that the Unit number that is specified in the communications dialog is not 
related to the Special I/O Unit number as set by the rotary switches on the top of CV-
series SIO units. 

DeviceNet  
The DeviceNet conforms to the DeviceNet open field network specification, which means that devices (Master 
and Slave) produced by other manufacturers can be connected to the Network. A wide range of field-level 
applications can thus be supported by combining valve devices, sensors, and other devices. 

Two types of communications are supported:  1. – Remote I/O master communications that automatically 
transfer I/O between Slaves and the CPU Unit without any special programming in the CPU Unit and  2. – 
Message communications that read/write messages, control operations, or perform other functions for Master 
Units, CPU Units to which a Master Unit is mounted. 

Differences between DeviceNet Network as FINS Network and other PLC Networks are as follows: 

1. Maximum Node number and Maximum number of Nodes are 63. 

2. No Datalink functionality. 

3. There are specific system setting areas and values for DeviceNet Network. Other application software 
(DeviceNet Configurator) will support these settings so CX-Net /CX-P does not need to support the system 
setting. 

 

 

The following diagram illustrates the connection options available to the C-series PLC. 

 

 
Possible Network Combinations - C-series PLC  

Note: Only the following C-series PLCs can be used as a gateway: C200H/HX/E/G/E-Z/G-
Z/X-Z, C1000H/HX/E/G/E-Z/G-Z/X-Z, C2000H. The C200HS PLC cannot be used 
as a gateway connection. For Ethernet, multiple destination access is possible.  
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The following diagram illustrates the connection options available to the CV-series PLC. 

 

 

 
Possible Network Combinations - CV-series PLC  

Note: For Ethernet, multiple destination access is possible. 

 



CX-Server Runtime - User Manual  
OMRON CHAPTER 3 – Communications 
 
 

Revision 2.4 CX-Server Runtime Page 25 

The following diagram illustrates the connection options available to the CS1-series PLC. 

 

 
Possible Network Combinations – CS1-series PLC  

Note: For Toolbus (Modem) and Ethernet, multiple destination access is possible. 
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SYSMAC LINK 
SYSMAC LINK is a high speed (2 Mbits/sec) industrial network supporting the connection of multiple C-series, 
CV-series, CS series and CJ series PLCs and one or more computers (so enabling the interchange of information 
between these devices). 

Communications are achieved by either Co-axial or Fibre Optic cabling and employing a SYSMAC LINK 
Network Service Board (NSB), and Microsoft Windows device drivers. 

Use the following procedure to configure SYSMAC LINK. 

1, 2, 3… 1. Ensure the Network Type is SYSMAC LINK. 
 2. Click on the associated Settings pushbutton in the Change PLC dialog. 
 3. In the Network tab, define the FINS Destination Address by entering the Network and 

Node. 
 4. Set the Response Timeout(s) to adjust for a slow network as necessary. 
 5. Enter the Frame Length in the Frame Length field. Refer to SYSMAC LINK 

documentation for further information. 
 6. In the Driver field, select the appropriate options from the Shared RAM address and 

Interrupt level fields. Refer to SYSMAC LINK documentation for further information. 
 7. Select the OK pushbutton to save the settings or select the Cancel pushbutton to abort the 

operation. 

SYSMAC NET 
SYSMAC NET is a high speed (2 Mbits/sec) LAN employed within medium/large scale systems (C-series PLCs 
and CV-series PLCs only). 

Connections between the various PLCs and computers is achieved by fibre optics in a ring or loop configuration 
allowing the exchange of data between the attached devices. The link is achieved by an NSB and employment of 
Microsoft Windows device drivers. Refer to the SYSMAC NET Network Support Board manual for details on 
installation. 

Use the following procedure to configure SYSMAC NET. 

1, 2, 3… 1. Ensure the Network Type is SYSMAC NET. 
 2. Click on the associated Settings pushbutton in the Change PLC dialog. 
 3. In the Network tab, define the FINS Destination Address by entering the Network and 

Node. 
 4. Set the Response Timeout(s) to adjust for a slow network as necessary. 
 5. Enter the Frame Length in the Frame Length field. Refer to SYSMAC NET 

documentation for further information. 
 6. Select the OK pushbutton to save the settings or select the Cancel pushbutton to abort 

the operation. 

Controller Link 
The Controller Link is an Factory Automation network that can send and receive large data packets flexibly and 
easily among the PLCs and IBM PC/AT or compatible computers. 

The Controller Link supports data links that enable data sharing and a message service that enables sending and 
receiving data when required. Data link areas can be freely set to create a flexible data link system and 
effectively use data areas using the CX-Net Network Configuration tool. Refer the to PLC Tools User Manual 
Chapter 8 - CX-Net Network Configuration Tool for further details. 

The network is connected using shielded twisted-pair cable and high-volume data transmissions at high speed 
enable construction of a wide range of networks, from low level systems to high. The link between attached 
devices and the network is achieved by an OMRON Controller Link NSB (PCI and ISA) and FinsGateway 
Version 3. Refer to the Controller Link operation manual for further details on installation. 

CS/CJ/CP-Series PLCs support the wired Controller Link and the new optical Controller Link network. 

Use the following procedure to configure Controller Link. 

1, 2, 3… 1. Ensure the Network Type is Controller Link. 
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 2. Click on the associated Settings pushbutton in the Change PLC dialog. 
 3. In the Network tab, define the FINS Destination Address by entering the Network and 

Node. 
 4. Set the Response Timeout(s) to adjust for a slow network as necessary. 
 5. Enter the Frame Length in the Frame Length field. Refer to Controller Link 

documentation for further information. 
 6. In the Driver tab, set the appropriate setting for the Shared RAM Address, Interrupt Level 

and Baud Rate fields. Refer to Controller Link documentation for further information. 
 7. Select an appropriate Node and Unit for the Network address. 
 8. Select the OK pushbutton to save the settings or select the Cancel pushbutton to abort the 

operation. 

Ethernet 
Ethernet is a commonly used network capable of achieving a high rate of data transmission.  

An NIC board must be installed inside the computer and TCP/IP protocols must be added and configured. 

Use the following procedure to configure Ethernet. 

1, 2, 3… 1. Ensure the Network Type is Ethernet. 
 2. Click on the associated Settings pushbutton in the Change PLC dialog. 
 3. In the Network tab define the FINS Source Address: Network field by entering the 

Network Address. 
 4. Check the Network and Node addresses for the PLC and enter them in the FINS 

Destination Address: Network field and Node field respectively. 
 5. Set the Response Timeout(s) to adjust for a slow network. 
 6. Enter the Frame Length in the Frame Length field. 
 7. In the Driver tab, check the Workstation Address and enter it in the Workstation: Node 

Number field. Alternatively, select the Auto Detect setting to automatically determine the 
workstation address. 

 8. Check the PLC IP address and enter it in the PLC: IP Address field. 
 9. Check the FINS UDP Port Number and enter it in the PLC: Port Number field. 
 10. Select the OK pushbutton to accept the settings. Select the Cancel pushbutton to abort the 

operation. 

Note: If using a subnet mask which is not 255.255.255.0 you will need to add the IP Address of the 
PC wishing to connect, into the Ethernet unit. Do this using the I/O table. 

PROM Writer 
PROM Writer is a device allowing Programmable Read Only Memory (PROM) to be written to. 

The following connection is required: 

♦  RS232 connection via a standard serial port on the computer (COM1 etc.). 
The Driver tab of the Network Settings dialog is similar to that belonging to SYSMAC WAY, however, the 
transmission conditions should be set to: 

♦  Baud Rate = 9600 
♦  Data Bits = 8 
♦  Parity = none 
♦  Stop Bits = 1 
♦  or those of the particular PROM writer unit being used. 
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CHAPTER 4 
Import/Export Tool 

This chapter describes the use of the CX-Server Import/Export tool, which allows FinsServer database files and 
CVSS and LSS definitions of addresses and PLCs to be imported into CX-Server project files. SYSWIN Text 
files can also be imported. 

A CX-Server project file contains definitions of addresses and PLCs which may be accessed. The concept of 
address and PLC definitions is not unique to CX-Server – the OMRON products CVSS and LSS have similar 
concepts. 

The Import/Export tool allows these definitions to be used by importing them into a CX-Server project file. 

Once these definitions of the PLCs and points (addresses) have been imported for use with CX-Server, they may 
be used by a CX-Server client. For example, the addresses used in a CVSS program could be used by the 
supervisory program SYSMAC-SCS. 

 
The status bar provides instant help.  

The Import/Export tool main window provides all the menu options for importing CVSS, LSS, text and 
FinsServer files into a CX-Server project file. 

The main window shows the status of any import or export event which occurs. It shows any decision which the 
Import/Export tool makes about importing into a CX-Server project. 

 
The main window is continually updated with information as import and export procedures are 
performed. This information can be cleared by selecting the Clear Screen button from the 
toolbar.  

For moving, resizing, maximising, minimising and closing windows, refer to Microsoft Windows online help for 
further information. 

 
To access the Import/Export tool click the Start pushbutton on the Microsoft Windows 
taskbar and select Programs/Omron/CX-Server/Import/Export from the menu. 

 
To close the Import/Export tool, select the Close button in the title bar.  

Supported Import/Export Data 
Data which can be imported/exported varies according to the method used to create it. 

CVSS creates information about PLCs and addresses. There are many types of file generated by CVSS which 
have different filename suffixes and have different uses:  

♦  PCN. This is a definition of a PLC, containing a name, network number and node number. 
♦  SBL. This is a table of names with addresses, similar to a CX-Server point definition. 
♦  CMT. This is a table of address comments. The addresses listed usually match those used in the SBL file. 
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♦  CUS. This contains the definitions of custom prefixes for data-areas and CIO groups which are defined for 
the program. 

LSS generates a single file (with the suffix .DAT) which contains details about many PLC programs. The file’s 
information is organised into records about a single program. The only information stored about the program 
which is useful in CX-Server is a table of address comments. Both LSS v3 and LSS v6 files can be imported.  

Text files are similar to Microsoft Windows ‘.INI’ files in structure. Headers within this file identify a chapter of 
addresses and a chapter of PLC information. Addresses can be imported from the text file for a CX-Server 
project PLC. Address definitions (points) inside a chosen CX-Server project PLC that are contained in a single 
CX-Server project point group can be exported.  

FinsServer files are tagged database files (with the suffix ‘.MDB’) containing node, PLC and network details. 

Note: FinsServer tagged database utilities must be installed on the PC to import/export 
‘.MDB’ files. 

CX-Server Project Selection  
In order to import information you must first open an existing CX-Server project file. The Project menu 
contains options for selection and editing of a CX-Server project. The importing operations then affect this CX-
Server project. Only one CX-Server project is selected at any one time.  

Use the following procedure to create a new CX-Server project. 

1, 2, 3… 1. Select the New button in the toolbar. The Create Project dialog is displayed. 

 
2. The CX-Server project must be saved before it can be edited. Enter a file name in the 

File name field. An existing CX-Server project can be overwritten by selecting a .CDM 
file displayed in the Create project dialog. 

 3. Select the Save pushbutton to save the new project or the Cancel pushbutton to abort the 
operation. CX-Server files have a .CDM extension.  

Use the following procedure to open an existing CX-Server project.  

1, 2, 3… 1. Select the Open button from the toolbar to open a CX-Server project file. 

 
2. A standard File Open dialog is displayed. Select a file from the Open dialog, followed by 

the Open pushbutton. PLC Memory files have a .CDM extension. 

 
3. Select the Edit option from the Project menu to edit a CX-Server project. Refer to 

Chapter 2 - Introduction to CX-Server Projects for further details. 
 4. Select Close from the Project menu to close the currently open CX-Server project. 

The content of the Import/Export tool can be printed. Use the following procedure to print details.  

1, 2, 3… 1. Select the Print button from the toolbar. A standard Print dialog is displayed. 

 
2. Set up the required printer settings. Select the OK pushbutton to print the PLC Memory 

details or the Cancel pushbutton to abort the operation. 

Import 
The following paragraphs describe the methods available for importing data into a CX-Server project. 

Importing from CVSS 
Use the following procedure to import from CVSS. 

1, 2, 3… 1. Select the Import CVSS button from the toolbar. A standard File Open dialog is shown; 
select a CVSS file to import and select the Open pushbutton or select the Cancel 
pushbutton to abort the operation. Specific CVSS file types can be selected from the 
Files of Type field: either CVSS PLCs, CVSS Memory, CVSS IO Names or CVSS IO 
Comments. Once the Open pushbutton has been selected,. The CVSS Import Options 
dialog is displayed. 



CX-Server Runtime - User Manual  
OMRON CHAPTER 4 – Import/Export Tool 
 
 

Revision 2.4 CX-Server Runtime Page 31 

 
2. To import points, (i.e. any addresses and address comments contained in the selected 

files) select a destination PLC from the Destination PLC field for the new addresses to 
use. The device type and CPU of the currently selected PLC is shown below the 
Destination PLC field. Alternatively, select a PLC from the Default Type field. Once 
imported, a message is displayed indicating that conversion is complete. 

Note: The Imported Points option or the Imported PLCs option is only available if the 
relevant type of object is found in the files chosen. 

PLC details can be edited via the Edit pushbutton. The procedure for doing this is described in Chapter 2 - 
Introduction to CX-Server Projects. 

Importing from LSS 
Use the following procedure to import from LSS. 

1, 2, 3… 1. Select the Import LSS button from the toolbar. A standard File Open dialog is shown: 
select a LSS file to import and select the Open pushbutton or select the Cancel 
pushbutton to abort the operation. The LSS Import Options dialog is displayed, listing 
the programs detailed in the file. 

 
2. Select a program from the Imported Program field. 

 3. Select the destination PLC from the Destination PLC field to which any addresses and 
comments found in the chosen program are to be added. The type of PLC that has been 
selected (device and CPU number) is shown below the drop-down list box. 

 4. Once imported, a message is displayed indicating that conversion is complete. 

PLC details can be edited via the Edit pushbutton. The procedure for doing this is described in Chapter 2 - 
Introduction to CX-Server Projects. 

Importing from Text Files 
Use the following procedure to import from Text. 

1, 2, 3… 1. Select the Import LSS button from the toolbar. A standard File Open dialog is shown: 
select a text file to import and click on OK or select the Cancel pushbutton to abort the 
operation. The Import Text File dialog is displayed. 

 
2. Select a PLC for which the address definitions in the file can be linked. The PLC type that 

is given in the file is shown. 
 
 

3. Select a matching device type from the list of PLCs which are contained in the current 
CX-Server project. This ensures that any imported addresses are valid on the chosen PLC. 
Once a file has been selected, the Import Text File dialog is displayed. Once imported, a 
message is displayed indicating that conversion is complete.  

PLC details can be edited via the Edit pushbutton. A PLC can be added if none are suitable for the import 
operation. Refer to Chapter 2 - Introduction to CX-Server Projects for further information. 

Importing from FinsServer 
Use the following procedure to import from FinsServer. 

1, 2, 3… 1. Select the Import from TagDB button from the toolbar. Provided FinsServer tagged 
database utilities has been correctly installed, the FinsServer Import Option dialog is 
displayed. 

 
2. Select the TagDB PLC name in the Node in TagDB field. Details of tags, device type and 

network nodes are displayed below the list box. 
•  +  The plus icon indicates that tagged data is assigned to the PLC listed in the Node in 

TagDB field. 
•  –  The minus icon indicates that there is no tagged data assigned to the PLC listed in 

the Node in TagDB field. It is not possible to import a node which has no tag data. 
 1. If required, enter a CX-Server project group name in the Group Name field ensuring that 

the name does not exceed 64 characters. By default, the field is set to ‘FinsServer’. 
 2. Enter a PLC comment to be written to each imported tag data in the Comment field. By 

default, the field is set to ‘Imported by FinsServer’. 
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 3. Set the Import to same name PLC field to ON to use the PLC in the current CX-Server 
project. Deselect the Import to same name PLC field to select a specific PLC from the 
PLC in Project field. If necessary, PLC details can be edited via the Edit Project 
pushbutton. Refer to Chapter 2 - Introduction to CX-Server Projects for further 
information. 

 4. Select the Import Tag pushbutton, an ‘Imported’ message is displayed once the operation 
has concluded. 

 
 

5. Select the Close pushbutton. The success or failure of the import operation is displayed in 
the Import/Export tool status dialog. Select the OK pushbutton to proceed. 

Note: The Import Tag pushbutton is disabled if the destination and source PLC types are 
different. If there are other differences (apart from PLC type), the import can proceed 
but no Export Log is generated. 

The maximum size of a TagDB is as follows: 

♦  Network: 20; 
♦  Node: 100; 
♦  Tag: 200 per Node. 
The maximum size of a CX-Server project is as follows: 

♦  PLC: 100; 
♦  Points: 200 per PLC. 

Export 
PLC data can be exported to either text or FinsServer files, for example symbol definitions can be exported as a 
FinsServer (‘.MDB’) file which can be read by Microsoft Excel (text files can also be imported into Microsoft 
Excel). 

Exporting Data to Text Files 
Use the following procedure to export all of the points from a particular point group, which are linked to a 
particular PLC (i.e. the point addresses refer to the PLC) to text file. 

1, 2, 3… 1. Select the Export Text button from the toolbar. The Export Text File dialog is displayed. 

 
2. Select a PLC from the Source PLC field. 

 3. It is possible to extract only partial data by inserting a path for a particular point by 
entering a pathname in Source Point Group field. 

 4. Select the OK pushbutton to accept the settings. Select the Cancel pushbutton to abort the 
operation. Select the Edit Project button to edit the CX-Server project's PLC. Point 
definitions can also be added to the CX-Server project if desired, before export from this 
function. Refer to Chapter 2 - Introduction to CX-Server Projects for further information. 
Once the OK pushbutton has been selected, the Export Data File dialog is displayed. This 
is a standard Microsoft Windows File Open dialog. 

 5. Insert a filename to export in the File name field and click on OK or select the Cancel 
pushbutton to abort the operation. 

 
 

6. A message is displayed in the Import/Export tool that the export is beginning. Another 
message is shown indicating the success of the export. The device details of the chosen 
PLC are copied to the selected file if the export is successful. 

Exporting Data to FinsServer Files  
Use the following procedure to export data to FinsServer files. 

1, 2, 3… 1. Select the Export to TagDB button from the toolbar. The FinsServer Export Option dialog 
is displayed. 
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2. Select the PLC from the PLC in Project field. Details of tags, device type and network 

nodes are displayed below the list box. 
•  +  The plus icon indicates that tagged data is assigned to the PLC listed in the Node in 

TagDB field. 

•  -  The minus icon indicates that there is no tagged data assigned to the PLC listed in 
the Node in TagDB field. 

 3. Set the Export to same name PLC field to use the PLC in the current CX-Server project. 
Deselect the Export to same name PLC field to select a specific PLC from the PLC in 
Project field. If necessary, tag details can be edited via the Edit TagDB pushbutton. 
Details of device type and network nodes are displayed below the drop-down list. 

 4. Select the Export Point pushbutton. The Export Point pushbutton is disabled if the 
destination and source PLC types are different. If there are other differences (apart from 
PLC type) the export can proceed but no Export Log is generated. 

 
 

5. Select the Close pushbutton. The success or failure of the import operation is displayed 
in the Import/Export tool status dialog. Select the OK pushbutton to proceed. 
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CHAPTER 5 
DDE Manager Tool 

This chapter introduces the CX-Server DDE Manager tool and describes its use in providing the interface to 
other Microsoft Windows-based applications. 

The DDE Manager tool permits CX-Server to communicate with other Microsoft Windows programs via the 
Microsoft Windows Dynamic Data Exchange Management Library (DDEML) facility. The links established by 
the DDE Manager tool allows a Microsoft Windows application, such as Microsoft Excel or Lotus 123, to 
transmit instructions to CX-Server in order to update points or to obtain information about a PLC address. This 
functionality is achieved without the necessity of additional programming (although macro programming may 
be required in order to update information in a PLC address, depending on the used). 

The creation of such a link establishes a client/server relationship between the application and the CX-Server 
project, where the application is (usually) the client and CX-Server is the server. 

 
The dialogs available via the DDE Manager tool are the same as those illustrated in Chapter 2 - Introduction to 
CX-Server Projects; this chapter should be referred to for further information. 

The Restore option and Maximise option from the DDE Manager menu are not used. 

 
The DDE Manager tool is accessed from the Start pushbutton on the Microsoft Windows 
taskbar and appears as only a pushbutton in the taskbar.  

To close the DDE Manager tool, select the DDE Manager tool in the taskbar with the right-mouse button and 
click on Close. 

Establishing DDE Links 
For an application to obtain information from a PLC, a CX-Server project must first be set up via the DDE 
Manager tool. The project file should contain details of the PLC and the points which are to be referenced (an 
existing CX-Server project can also be used); the application references the CX-Server project via the point 
names within the project. 

When this information has been configured, the application which is requesting the point data must be opened in 
order to link it with CX-Server. The link can either be manually entered in the application or the reference can 
be copied from the CX-Server project. The manner in which such links are established within a Microsoft 
Windows application (supported by the DDE facility) varies according to the application used and so the 
appropriate reference manual must be consulted. 

Defining a Link 
The information contained within the link reference required by the DDE Manager tool must include service, 
topic and item identifiers. 

Service 
The service name indicating where the data is held is identified by the application specifier. Within CX-Server 
this is always ‘CDMDDE’. 
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Topic 
The CX-Server project name and the path by which it is accessed in CX-Server is identified by the topic 
specifier. The CX-Server project name is identified by the ‘.cdm’ extension; for example, “C:\CX-
Server\factory.cdm” identifies the CX-Server project ‘factory’ in the “C:\CX-Server” directory. 

Item 
The point to be referenced by the CX-Server project is identified by the item specifier, (this must also include 
the group path); for example “\pump1”.  

The complete reference for this point (defined by ‘factory.cdm’) would include the following information: 

♦  Service = “CDMDDE” 
♦  Topic = “C:\CX-Server\factory.cdm” 
♦  Item = “\pump1” 
Its interpretation into a link reference and the format this takes depends upon the application requesting the 
information (in which case it is necessary to refer to the appropriate application user manual); for example in 
Microsoft Excel the link would be entered in a cell as: 

“=CDMDDE!’C:\CX-Server\factory.cdm’!’\pump1’”.

 

Note: The address information for a point is held in the CX-Server project file indicated by 
the topic identifier. 

Copying a Point 
Although it is possible to enter details of a link in a client manually, it may be quicker to use the DDE Manager 
tool facility to format the link details automatically. 

The Project Editor (DDE Manager) allows a point to be linked to an application so that the contents of the point 
can be displayed within that application; it is obtained via the Copy Selection option on the DDE Manager 
menu. 
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Use the following procedure to copy a point: 

1, 2, 3… 1. Into another application, i.e. Microsoft Excel. 
(a) Open the DDE Manager and navigate to the appropriate location. 
(b) Select the point from the list displayed. If necessary select the required group from 

the Group hierarchy. 
(c) Select the Edit/Copy option or click the copy button to copy the selected point to 

the Microsoft Windows Clipboard. 
(d) Open the required application and position the cursor at the point in the application 

where this information is to be pasted; for example a Microsoft Excel cell. 
(e) Select the Paste option in the application to insert the copy. The exact nature of the 

Paste option varies according to the application and may takes the form of a Paste 
Special option. 

 2. Into another Device or Group: 
(a) Open the DDE Manager and navigate to the appropriate location. 
(b) Select the point from the Tree view. If necessary select the required group from the 

Group hierarchy. 
(c) Select the Edit/Copy option or click the Copy Selection button in the toolbar. 
(d) Navigate to the point where the information is to be pasted and select Edit/Paste or 

click the Paste Selection button. 
 Note that attempting to paste a copied point into the same location will warn you 

that a point of the same description already exists. 
Details about a point can be displayed by right clicking on the point and selecting the Properties option from the 
menu. 

Automatic versus Manual Updates  
The links created between an application and the CX-Server project can be defined as ‘active’, in which case the 
entry in the application file referencing that point is updated automatically with point data, or the link can be 
‘manual’, i.e. the user controls when and if point data in an application is updated. 

Automatic Updates 
The application requesting data relating to a specific point is updated by the DDE Manager tool whenever the 
point data changes; this occurs at defined time intervals when the DDE Manager tool examines the PLC address 
associated with the point to see whether the information it contains has changed or not. The update rate can be 
specified when the CX-Server project is created, alternatively the DDE Manager tool uses a default update rate 
if one has not been set. 

Update rates can be included when defining the item specifier chapter of the DDE link; for example, a time 
interval of 5 seconds for the item specified by “\pump1” is expressed as “\pump1,5”. The full DDE link 
becomes: “=CDMDDE1‘C:\CX-Server\factory.cdm’!’\pump1,5’” 
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An update rate indicated in this manner overrides the default rate. 

Manual Updates 
If a manual link has been specified between an application and the CX-Server project, the information contained 
within the application is not updated until the appropriate action is taken by the user. 

Within Microsoft Excel, this would be achieved by highlighting the cell containing the link and selecting 
Calculate Now from the Options menu to update the displayed contents of the cell. 

Defining Update Intervals 
The Update Interval dialog allows a default update rate (in seconds) to be assigned to new data requests. Use the 
following procedure to define an update interval: 

1, 2, 3… 1. Select the Update Interval option from the DDE Manager menu. 
 2. Enter the required update rate (in seconds) in the Interval field; this has a maximum 

value of 65535. 
 3. Select the OK pushbutton to save the setting and close the dialog. 

The new rate applies to those points which are activated after this rate has been set. Currently active points are 
not affected. 

Note: The default time interval for the DDE Manager tool (when it is initially installed) is 
set to 15 seconds. 

Special Data Types 
The LREAL data type is now supported by the Points Editor for the CS1H-H and CJ1H-H PLCs. Support for the 
LREAL type is as the IEEE754 Double precision (1.7E +308/-307) as defined by Microsoft®. 
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CHAPTER 6 
Performance Monitor Tool 

The Performance Monitor tool provides a facility to monitor system performance of active connections and can 
also display the limits of performance against user instructions. 

Particularly, it allows monitoring of communications. For example, a SYSMAC WAY connection configured at 
9,600 baud, 7 data bits, even parity and 2 stop bits, transmits 10 bits per byte at 9,600 bits per second; this 
means that the absolute maximum throughput of the cable is 960 bytes per second. Requesting or transmitting 
data at this rate results in slow response times. The Performance Monitor tool has been engineered to show this 
throughput figure for PLC connections. 

The Performance Monitor tool can be set so that it is not obscured by other windows by selecting Always on top 
from the Options menu. 

 
To access the Performance Monitor tool select the CX-Server Performance Monitor tool from 
the Start pushbutton on the Microsoft Windows taskbar.  

 
To close the Performance Monitor tool, select the Close button in the title bar.  

 
The Performance tab displays an automated performance history and performance load for the selected active 
connection in the Component option or for the overall performance. Details of activity are described in terms of 
the number of open PLCs, active messages and open points in the Totals field.  

The Statistics tab displays the number of bytes being transmitted and received by the selected active connection. 
The limit to the number of characters that can be processed per second is described by the Theoretical CPS field. 
The number of characters currently active is described by the Active CPS field. The PLC Average Latency (ms) 
option shows how long it is taking the PLC to process the information in milliseconds. 

Watching the Performance Monitor tool fluctuate between for example, 0% and 135%, indicates that it is 
actually not possible to retrieve all the data requested in the time required according to the connected baud rate. 

If the actual characters per second is greater than the theoretical maximum characters per second then 
performance decreases. The performance load will fluctuate and the PLC average latency will increase. At this 
point attention is required to the user instructions that are responsible for slowing performance. 

 
The taskbar setting provides an at-a-glance indication of performance. The more the icon is 
filled green, the greater the performance load. If the icon begins to fill red, then the actual 
characters per second is greater than the theoretical maximum characters per second load.  
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To refresh the Performance Monitor tool details, select the Refresh Now option from the View menu. 

The performance Monitor tool can be hidden from the desktop by minimising the window, and can be hidden 
from the taskbar in its minimised state by selecting Hide on Minimise option from the Options menu. Once 
hidden, the Performance Monitor tool can be restored by clicking the taskbar pushbutton or click the right-
mouse button and from the menu select restore. 
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CHAPTER 7 
Driver Management Tool 

The Driver Management Tool provides a simple method of installing and removing device drivers which 
support CX-Server 2.0 and higher. Device Drivers are essential parts of CX-Server version 2, and provide the 
support for a family of devices, or a single device.  

This tool is not compatible with versions of CX-Server earlier than version 2.0.  

The tool allows adding and removing of devices, and also providing some basic information about which 
Drivers are present on a system along with their description. 

 To access the Driver Management Tool select the ‘Programs->Omron->Driver Management 
tool’ from the Start pushbutton on the Microsoft Windows taskbar.  

 Alternatively, access to the Driver Management Tool is also possible from the Windows 
Control Panel. 

 
To close the Driver Management Tool, select the Close button in the title bar.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

A list of available drivers will be shown on the left pane of the main window. The list is generated when the 
Driver Management Tool is first opened, and obtained by performing a scan of your computer. When drivers are 
found, they are shown on the left pane, and once selected, the information about the selected driver is shown in 
the right pane. 

If nothing appears in the left pane, then it means that no drivers were found; however, many device types do not 
require drivers, and thus a device driver absence does not necessarily mean an absence of support. Devices that 
do not require drivers include all PLCs released before 2003 (except CS/CJ/CP-Series) that CX-Server version 
1.7 supported. 

Drivers can be installed onto a machine from any form of media, for example a CD. To add a driver, press the 
'Add' button. A standard open file window will be shown. Select the media from which a driver is to be sourced, 
from the pull-down menu at the top of the window. Now select a driver (file) which will contain information to 
support a specific group of PLCs, and press open. 

Use the following procedure to add a driver support to your computer. 

1, 2, 3… 1. Open the Driver management Tool from Start->Omron->CX-Server-> or Control panel. 
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 2. Select the Add button on the screen. A standard File Open dialog is shown: Select the 
driver file to be installed. The driver is usually called ‘Setup.exe’. Refer to your driver 
provider for exact details of the driver. 

 3. Click on Open or select the Cancel pushbutton to abort the operation.  
 4. The Driver Management Tool will now automatically update the computer, making it 

possible to use a larger range of devices via CX-Server. 
 

In the future, as device families are extended, existing drivers may require updating, however the process for 
this modification remains the same as for adding anew. 

Note: It is possible to add drivers through a variety of other means, which do not require the 
Driver Management Tool to be active. 

It is possible to remove drivers if they are no longer required.  

Use the following procedure to remove a driver from your computer 

1, 2, 3… 1. Open the Driver management Tool from Start->Omron->CX-Server-> or Control panel 
 2. Select the Driver to be removed in the left hand pane. 
 3. Select the Remove button on the screen. 
 4. Follow the driver uninstaller screen prompts for each driver. 
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APPENDIX A 
Network Availability 

The following tables indicate the network available to each PLC device group. FinsGateway has no network 
availability and is not described. 

Note: Modem connection is also available by Toolbus or SYSMAC WAY if a Modem 
device has been configured in Microsoft Windows. Any device supporting Toolbus or 
SYSMAC WAY also supports Modem connections. Refer to standard Microsoft 
Windows documentation for details on configuring a Modem device. 

Note: Where DeviceNet is indicated as an available network type for a given PLC, direct 
connection from a PC is not possible (No NSB support). Instead, connect via a Serial 
Port (COM1 etc.), or another network type. 

C**H Device Group 
Device 
Type 

SYSMAC 
WAY 

Toolbus SYSMAC 
NET 

SYSMAC
LINK 

Controller
Link 

Ethernet Device 
Net 

C20H Yes - - - - - - 

C28H Yes - - - - - - 

C40H Yes - - - - - - 

C60H Yes - - - - - - 

C**K Device Group 
Device 
Type 

SYSMAC 
WAY 

Toolbus SYSMAC 
NET 

SYSMAC 
LINK 

Controller 
Link 

Ethernet Device 
Net 

C20K Yes - - - - - - 

C28K Yes - - - - - - 

C40K Yes - - - - - - 

C60K Yes - - - - - - 

C**P Device Group 
Device 
Type 

SYSMAC 
WAY 

Toolbus SYSMAC 
NET 

SYSMAC 
LINK 

Controller 
Link 

Ethernet Device 
Net 

C20P  Yes - - - - - - 

C28P Yes - - - - - - 

C40P Yes - - - - - - 

C60P Yes - - - - - - 
 

C1000H Device Group 
Device 
Type 

SYSMAC 
WAY 

Toolbus SYSMAC 
NET 

SYSMAC 
LINK 

Controller 
Link 

Ethernet Device 
Net 

CPU01 Yes - Yes Yes - - - 
 

C20 Device Group 
Device 
Type 

SYSMAC 
WAY 

Toolbus SYSMAC 
NET 

SYSMAC 
LINK 

Controller 
Link 

Ethernet Device 
Net 

C20 Yes - - - - - - 
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C2000H Device Group 
Device 
Type 

SYSMAC 
WAY 

Toolbus SYSMAC 
NET 

SYSMAC 
LINK 

Controller 
Link 

Ethernet Device 
Net 

CPU01 Yes - Yes Yes - - - 

C2000 Yes - Yes - - - - 
 

C200H Device Group 
Device 
Type 

SYSMAC 
WAY 

Toolbus SYSMAC 
NET 

SYSMAC 
LINK 

Controller 
Link 

Ethernet Device 
Net 

CPU01 Yes - - - - - - 

CPU02 Yes - - - - - - 

CPU03 Yes - - - - - - 

CPU21 Yes - - - - - - 

CPU21 Yes - - - - - - 

CPU22 Yes - - - - - - 

CPU23 Yes - - - - - - 

CPU11 Yes - Yes Yes - - - 

CPU31 Yes - Yes Yes - - - 

C200HE Device Group 
Device Type SYSMAC 

WAY 
Toolbus SYSMAC 

NET 
SYSMAC 

LINK 
Controller 

Link 
Ethernet Device 

Net 

CPU11 - Yes - - - - - 

CPU32 - Yes Yes Yes Yes Yes - 

CPU42 Yes Yes Yes Yes Yes Yes - 
 

C200HE-Z Device Group 
Device Type SYSMAC 

WAY 
Toolbus SYSMAC 

NET 
SYSMAC 

LINK 
Controller 

Link 
Ethernet Device 

Net 

CPU11 Yes Yes - - - - - 

CPU32 Yes Yes Yes Yes Yes Yes - 

CPU42 Yes Yes Yes Yes Yes Yes - 
 

C200HG Device Group 
Device Type SYSMAC 

WAY 
Toolbus SYSMAC 

NET 
SYSMAC 

LINK 
Controller 

Link 
Ethernet Device 

Net 

CPU33 Yes Yes Yes Yes Yes Yes - 

CPU43 Yes Yes Yes Yes Yes Yes - 

CPU53 Yes Yes Yes Yes Yes Yes - 

CPU63 Yes Yes Yes Yes Yes Yes - 
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C200HG-Z Device Group 
Device Type SYSMAC 

WAY 
Toolbus SYSMAC 

NET 
SYSMAC 

LINK 
Controller 

Link 
Ethernet Device 

Net 

CPU33 Yes Yes Yes Yes Yes Yes - 

CPU43 Yes Yes Yes Yes Yes Yes - 

CPU53 Yes Yes Yes Yes Yes Yes - 

CPU63 Yes Yes Yes Yes Yes Yes - 
 

C200HS Device Group 
Device Type SYSMAC 

WAY 
Toolbus SYSMAC 

NET 
SYSMAC 

LINK 
Controller 

Link 
Ethernet Device 

Net 

CPU01 Yes Yes - - - - - 

CPU03 Yes Yes - - - - - 

CPU11 Yes Yes Yes Yes - - - 

CPU13 Yes Yes Yes Yes - - - 
 

C200HX Device Group 
Device Type SYSMAC 

WAY 
Toolbus SYSMAC 

NET 
SYSMAC 

LINK 
Controller 

Link 
Ethernet Device 

Net 

CPU34 - Yes Yes Yes Yes Yes - 

CPU44 Yes Yes Yes Yes Yes Yes - 

CPU54 - Yes Yes Yes Yes Yes - 

CPU64 Yes Yes Yes Yes Yes Yes - 
 

C200HX-Z Device Group 
Device Type SYSMAC 

WAY 
Toolbus SYSMAC 

NET 
SYSMAC 

LINK 
Controller 

Link 
Ethernet Device 

Net 

CPU34 Yes Yes Yes Yes Yes Yes - 

CPU44 Yes Yes Yes Yes Yes Yes - 

CPU54 Yes Yes Yes Yes Yes Yes - 

CPU64 Yes Yes Yes Yes Yes Yes - 
 

C500 Device Group 
Device Type SYSMAC 

WAY 
Toolbus SYSMAC 

NET 
SYSMAC 

LINK 
Controller 

Link 
Ethernet Device 

Net 

C500 Yes - Yes - - - - 

C250 Yes - - - - - - 

C120 Yes - - - - - - 

C50 Yes - - - - - - 
 

CJ1G Device Group 
Device Type SYSMAC 

WAY 
Toolbus SYSMAC 

NET 
SYSMAC 

LINK 
Controller 

Link 
Ethernet Device 

Net 

CPU45 Yes Yes - - Yes Yes Yes 

CPU44 Yes Yes - - Yes Yes Yes 
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CJ1G-H / CJ1G-H(FB) Device Group 
Device Type SYSMAC 

WAY 
Toolbus SYSMAC 

NET 
SYSMAC 

LINK 
Controller 

Link 
Ethernet Device 

Net 

CPU45 Yes Yes - - Yes Yes Yes 

CPU44 Yes Yes - - Yes Yes Yes 

CPU43 Yes Yes - - Yes Yes Yes 

CPU42 Yes Yes - - Yes Yes Yes 

CJ1H-H Device Group 
Device Type SYSMAC 

WAY 
Toolbus SYSMAC 

NET 
SYSMAC 

LINK 
Controller 

Link 
Ethernet Device 

Net 

CPU66 Yes Yes - Yes Yes Yes Yes 

CPU65 Yes Yes - Yes Yes Yes Yes 

CJ1M Device Group 
Device Type SYSMAC 

WAY 
Toolbus SYSMAC 

NET 
SYSMAC 

LINK 
Controller 

Link 
Ethernet Device 

Net 

CPU12 Yes Yes - - Yes Yes Yes 

CPU13 Yes Yes - - Yes Yes Yes 

CPU22 Yes Yes - - Yes Yes Yes 

CPU23 Yes Yes - - Yes Yes Yes 

CPM1 (CPM1A/CPM2*) Device Group 
Device Type SYSMAC 

WAY 
Toolbus SYSMAC 

NET 
SYSMAC 

LINK 
Controller 

Link 
Ethernet Device 

Net 

CPU10 Yes Yes - - - - - 

CPU20 Yes Yes - - - - - 

CPU30 Yes Yes - - - - - 

CPM2*-S* Device Group 
Device Type SYSMAC 

WAY 
Toolbus SYSMAC 

NET 
SYSMAC 

LINK 
Controller 

Link 
Ethernet Device 

Net 

N/A Yes Yes - - - - Yes 
 

CQM1 Device Group 
Device Type SYSMAC 

WAY 
Toolbus SYSMAC 

NET 
SYSMAC 

LINK 
Controller 

Link 
Ethernet Device 

Net 

CPU11 Yes Yes - - - - - 

CPU21 Yes Yes - - - - - 

CPU41 Yes Yes - - - - - 

CPU42 Yes Yes - - - - - 

CPU43 Yes Yes - - - -  

CPU44 Yes Yes - - - -  
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CQM1H Device Group 
Device Type SYSMAC 

WAY 
Toolbus SYSMAC 

NET 
SYSMAC 

LINK 
Controller 

Link 
Ethernet Device 

Net 

CPU11 Yes Yes - - - - - 

CPU21 Yes Yes - - - - - 

CPU51 Yes Yes - - Yes - - 

CPU61 Yes Yes - - Yes - - 
 

CS1G / CS1G-H / CS1G-H(FB) Device Group 
Device Type SYSMAC 

WAY 
Toolbus SYSMAC 

NET 
SYSMAC 

LINK 
Controller 

Link 
Ethernet Device 

Net 

CPU45 Yes Yes - Yes Yes Yes Yes 

CPU44 Yes Yes - Yes Yes Yes Yes 

CPU43 Yes Yes - Yes Yes Yes Yes 

CPU42 Yes Yes - Yes Yes Yes Yes 

CS1H / CS1H-H / CS1H-H(FB) Device Group 
Device Type SYSMAC 

WAY 
Toolbus SYSMAC 

NET 
SYSMAC 

LINK 
Controller 

Link 
Ethernet Device 

Net 

CPU67 Yes Yes - Yes Yes Yes Yes 

CPU66 Yes Yes - Yes Yes Yes Yes 

CPU65 Yes Yes - Yes Yes Yes Yes 

CPU64 Yes Yes - Yes Yes Yes Yes 

CPU63 Yes Yes - Yes Yes Yes Yes 
 

IDSC Device Group 
Device Type SYSMAC 

WAY 
Toolbus SYSMAC 

NET 
SYSMAC 

LINK 
Controller 

Link 
Ethernet Device 

Net 

C01 Yes Yes - - - - - 

C02 Yes Yes - - - - - 

SRM1 – SRM1 V2 Device Group 
Device Type SYSMAC 

WAY 
Toolbus SYSMAC 

NET 
SYSMAC 

LINK 
Controller 

Link 
Ethernet Device 

Net 

C01 Yes Yes - - - - - 

C02 Yes Yes - - - - - 

CV1000 Device Group 
Device Type SYSMAC 

WAY 
Toolbus SYSMAC 

NET 
SYSMAC 

LINK 
Controller 

Link 
Ethernet Device 

Net 

CPU01 Yes Yes Yes Yes Yes Yes - 

CV2000 Device Group 
Device Type SYSMAC 

WAY 
Toolbus SYSMAC 

NET 
SYSMAC 

LINK 
Controller 

Link 
Ethernet Device 

Net 

CPU01 Yes Yes Yes Yes Yes Yes - 
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CV500 Device Group 
Device Type SYSMAC 

WAY 
Toolbus SYSMAC 

NET 
SYSMAC 

LINK 
Controller 

Link 
Ethernet Device 

Net 

CPU01 Yes Yes Yes Yes Yes Yes - 

CVM1 Device Group 
Device Type SYSMAC 

WAY 
Toolbus SYSMAC 

NET 
SYSMAC 

LINK 
Controller 

Link 
Ethernet Device 

Net 

CPU01 Yes Yes Yes Yes Yes Yes - 

CPU11 Yes Yes Yes Yes Yes Yes - 

CVM1-V2 Device Group 
Device Type SYSMAC 

WAY 
Toolbus SYSMAC 

NET 
SYSMAC 

LINK 
Controller 

Link 
Ethernet Device 

Net 

CPU01 Yes Yes Yes Yes Yes Yes - 

CPU11 Yes Yes Yes Yes Yes Yes - 

CPU21 Yes Yes Yes Yes Yes Yes - 
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APPENDIX B 
PLC Memory Areas 

The following tables provide memory area details for each device group. 

Some tables indicate special addresses. These can be as follows: 

♦  CLOCK. This allows reading/writing of a PLC's real-time clock. 
♦  BANKNO. This allows reading/writing of a PLC's extended memory bank number. 
♦  MODE. This allows reading/writing of a PLC's run-mode.  

C**H Device Group 
Prefix Start 

Channel 
End Channel Word 

Addressing 
Bit 

Addressing 
Read 
Write 

Modifiers 

AR 0 27 Yes Yes Yes F C 

TC 0 511 Present Value Status Yes F C 

DM 0 1999 Yes No Yes  

HR 0 99 Yes Yes Yes F C 

IR (opt) 0 252 Yes Yes Yes F C 

IR (opt) 253 255 (bit 7) Yes Yes No  

LR 0 63 Yes Yes Yes F C 

SR (opt) 247 252  Yes Yes Yes F C 

SR (opt) 253 255 (bit 7) Yes Yes No  

TR 0 0 (bit 7) No Yes No  
 
Special addresses CLOCK, MODE. 

C**K Device Group 
Prefix Start 

Channel 
End Channel Word 

Addressing 
Bit 

Addressing 
Read 
Write 

Modifiers 

TC 0 47 Present Value Status Yes F C 

DM 0 63 Yes No Yes  

HR 0 9 Yes Yes Yes F C 

IR (opt) 0 18 (bit 7) Yes Yes Yes F C 

SR (opt) 18 (bit 8) 19 (bit 7) No Yes No  

TR 0 0 (bit 7) No Yes No  
 

C**P Device Group 
Prefix Start 

Channel 
End Channel Word 

Addressing 
Bit 

Addressing 
Read 
Write 

Modifiers 

TC 0 47 Present Value Status Yes F C 

DM 0 63 Yes No Yes  

HR 0 9 Yes Yes Yes F C 

IR (opt) 0 18 (bit 7) Yes Yes Yes F C 

SR (opt) 18 (bit 8) 19 (bit 7) No Yes No  

TR 0 0 (bit 7) No Yes No  
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C1000H Device Group 
Prefix Start 

Channel 
End Channel Word 

Addressing 
Bit 

Addressing 
Read 
Write 

Modifiers 

AR 0 27 Yes Yes Yes F C 

TC 0 511 Present Value Status Yes F C  

DM 0 4095 Yes No Yes  

HR 0 99 Yes Yes Yes F C 

IR (opt) 0 236 Yes Yes Yes F C 

LR 0 63 Yes Yes Yes F C 

SR (opt) 237  252 Yes Yes Yes F C 

SR (opt) 253 255 (bit 7) Yes Yes No  

TR 0 0 (bit 7) No Yes No  
 
Special addresses: MODE. 

C20 Device Group 
Prefix Start 

Channel 
End Channel Word 

Addressing 
Bit 

Addressing 
Read 
Write 

Modifiers 

TC  0 47 Present Value Status Yes F C 

HR 0 9 Yes Yes Yes F C 

IR (opt) 0 18 (bit 7) Yes Yes Yes F C 

SR (opt) 18 (bit 8) 19 (bit 7) No Yes No  

TR 0 0 (bit 7) No Yes No  
 

C2000H Device Group 
Prefix Start 

Channel 
End Channel Word 

Addressing 
Bit 

Addressing 
Read 
Write 

Modifiers 

AR 0 27 Yes Yes Yes F C 

TC 0 511 Present Value Status Yes F C  

DM 0 6655 Yes No Yes  

HR 0 99 Yes Yes Yes F C 

IR (opt) 0 236 Yes Yes Yes F C 

LR 0 63 Yes Yes Yes F C 

SR (opt) 237 252  Yes Yes Yes F C 

SR (opt) 253 255 (bit 7) Yes Yes No  

TR 0 0 (bit 7) No Yes No  
 
Special addresses: MODE. 
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C200H Device Group 
Prefix Start 

Channel 
End Channel Word 

Addressing 
Bit 

Addressing 
Read 
Write 

Modifiers 

AR 0 27 Yes Yes Yes F C 

DM 0 1999 Yes No Yes  

HR 0 99 Yes Yes Yes F C 

IR (opt) 0 235 Yes Yes Yes F C 

LR 0 63 Yes Yes Yes F C 

SR (opt) 236 252  Yes Yes Yes F C 

SR (opt) 253 255 (bit 7) Yes Yes No  

TR 0 0 (bit 7) No Yes No  

TC 0 511 Present Value Status Yes F C 
 
Special addresses: CLOCK, MODE. 

C200HE Device Group 

General Memory Areas 
Memory Areas for any CPU. 

Prefix Start 
Channel 

End Channel Word 
Addressing 

Bit 
Addressing 

Read 
Write 

Modifiers 

AR 0 27 Yes Yes Yes F C 

DM 0 4095 Yes No Yes  

DM 6000 6655 Yes No Yes  

HR 0 99 Yes Yes Yes F C 

IR (opt) 0 235 Yes Yes Yes F C 

IR (opt) 300 511 Yes Yes Yes F C 

LR 0 63 Yes Yes Yes F C 

SR (opt) 236 252  Yes Yes Yes F C 

SR (opt) 253 255 (bit 7) Yes Yes No  

SR (opt) 256 299 Yes Yes Yes FC 

TR 0 0 (bit 7) No Yes No  

SR (opt) 256 299 Yes Yes Yes F C 

TC 0 511 Present Value Status Yes F C 
 

CPU 32/42 Memory Areas 
Memory Areas in addition to general memory areas. 

Prefix Start 
Channel 

End Channel Word 
Addressing 

Bit 
Addressing 

Read 
Write 

Modifiers 

DM 4096 5999 Yes No Yes  
 
Special addresses: CLOCK, MODE. 
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C200HE-Z Device Group 

General Memory Areas 
Memory Areas for any CPU. 

Prefix Start 
Channel 

End Channel Word 
Addressing 

Bit 
Addressing 

Read 
Write 

Modifiers 

AR 0 27 Yes Yes Yes F C 

DM 0 4095 Yes No Yes  

DM 6000 6655 Yes No Yes  

HR 0 99 Yes Yes Yes F C 

IR (opt) 0 235 Yes Yes Yes F C 

IR (opt) 300 511 Yes Yes Yes F C 

LR 0 63 Yes Yes Yes F C 

SR (opt) 236 252  Yes Yes Yes F C 

SR (opt) 253 255 (bit 7) Yes Yes No  

SR (opt) 256 299 Yes Yes Yes FC 

TR 0 0 (bit 7) No Yes No  

SR (opt) 256 299 Yes Yes Yes F C 

TC 0 511 Present Value Status Yes F C 
 

CPU 32/42 Device Group 
Memory Areas in addition to general memory areas. 

Prefix Start 
Channel 

End Channel Word 
Addressing 

Bit 
Addressing 

Read 
Write 

Modifiers 

DM 4096 5999 Yes No Yes  
 
Special addresses: CLOCK, MODE. 

C200HG Device Group 
Prefix Start 

Channel 
End Channel Word 

Addressing 
Bit 

Addressing 
Read 
Write 

Modifiers 

AR 0 27 Yes Yes Yes F C 

DM 0 6655 Yes No Yes  

HR 0 99 Yes Yes Yes F C 

IR (opt) 0 235 Yes Yes Yes F C 

IR (opt) 300 511 Yes Yes Yes F C 

LR 0 63 Yes Yes Yes F C 

SR (opt) 236 252 Yes Yes Yes F C 

SR (opt) 253 255 (bit 7) Yes Yes No  

SR (opt) 256 299 Yes Yes Yes F C 

TR 0 0 (bit 7) No Yes No  

TC 0 511 Present Value Status Yes F C 

EM 0 6143 * 1 Yes No Yes -n 
 
Special addresses: CLOCK, MODE, BANKNO. 
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C200HG-Z Device Group 
Prefix Start 

Channel 
End Channel Word 

Addressing 
Bit 

Addressing 
Read 
Write 

Modifiers 

AR 0 27 Yes Yes Yes F C 

DM 0 6655 Yes No Yes  

HR 0 99 Yes Yes Yes F C 

IR (opt) 0 235 Yes Yes Yes F C 

IR (opt) 300 511 Yes Yes Yes F C 

LR 0 63 Yes Yes Yes F C 

SR (opt) 236 252 Yes Yes Yes F C 

SR (opt) 253 255 (bit 7) Yes Yes No  

SR (opt) 256 299 Yes Yes Yes F C 

TR 0 0 (bit 7) No Yes No  

TC 0 511 Present Value Status Yes F C 

EM 0 6143 * 1 Yes No Yes -n 
 
Special addresses: CLOCK, MODE, BANKNO. 

C200HS Device Group 
Prefix Start 

Channel 
End Channel Word 

Addressing 
Bit 

Addressing 
Read 
Write 

Modifiers 

AR 0 27 Yes Yes Yes F C 

DM 0 6655 Yes No Yes  

HR 0 99 Yes Yes Yes F C 

IR (opt) 0 235 Yes Yes Yes F C 

IR (opt) 300 511 Yes Yes Yes F C 

LR 0 63 Yes Yes Yes F C 

SR (opt) 236 252 Yes Yes Yes F C 

SR (opt) 253 255 (bit 7) Yes Yes No  

SR (opt) 256 299 Yes Yes Yes F C 

TC 0 511 Present Value Status Yes F C 

TR 0 0 (bit 7) No Yes No  
 
Special addresses: CLOCK, MODE. 
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C200HX Device Group 
Prefix Start 

Channel 
End Channel Word 

Addressing 
Bit 

Addressing 
Read 
Write 

Modifiers 

AR 0 27 Yes Yes Yes F C 

DM 0 6655 Yes No Yes  

HR 0 99 Yes Yes Yes F C 

IR (opt) 0 235 Yes Yes Yes F C 

IR (opt) 300 511 Yes Yes Yes F C 

LR 0 63 Yes Yes Yes F C 

SR (opt) 236 252  Yes Yes Yes F C 

SR (opt) 253 255 (bit 7) Yes Yes No  

SR (opt) 256 299 Yes Yes Yes F C 

TR 0 0 (bit 7) No Yes No  

TC 0 511 Present Value Status Yes F C 

EM 0 6143 * 3 Yes No Yes -n 
 
Special addresses: CLOCK, MODE, BANKNO. 

C200HX-Z Device Group 
Prefix Start 

Channel 
End Channel Word 

Addressing 
Bit 

Addressing 
Read 
Write 

Modifiers 

AR 0 27 Yes Yes Yes F C 

DM 0 6655 Yes No Yes  

HR 0 99 Yes Yes Yes F C 

IR (opt) 0 235 Yes Yes Yes F C 

IR (opt) 300 511 Yes Yes Yes F C 

LR 0 63 Yes Yes Yes F C 

SR (opt) 236 252  Yes Yes Yes F C 

SR (opt) 253 255 (bit 7) Yes Yes No  

SR (opt) 256 299 Yes Yes Yes F C 

TR 0 0 (bit 7) No Yes No  

TC 0 511 Present Value Status Yes F C 

EM 0 6143 * 3 Yes No Yes -n 
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CPU 65 Memory Areas 
Memory Areas in addition to general memory areas. 

Prefix Start 
Channel 

End Channel Word 
Addressing 

Bit 
Addressing 

Read 
Write 

Modifiers 

EM 0 6143 * 8 Yes No Yes -n 
 

CPU 85 Memory Areas 
Memory Areas in addition to general memory areas. 

Prefix Start 
Channel 

End Channel Word 
Addressing 

Bit 
Addressing 

Read 
Write 

Modifiers 

EM 0 6143 * 16 Yes No Yes -n 
 
Special addresses: CLOCK, MODE, BANKNO. 

 

C500 Device Group 
Prefix Start 

Channel 
End Channel Word 

Addressing 
Bit 

Addressing 
Read 
Write 

Modifiers 

TC 0 127 Present Value Status Yes F C 

DM 0 511 Yes No Yes  

HR 0 31 Yes Yes Yes F C 

IR (opt) 0 57 Yes Yes Yes F C 

LR 0 31 Yes Yes Yes F C 

SR (opt) 58 60 Yes Yes Yes F C 

SR (opt) 61 63 (bit 7) Yes Yes No  

TR 0 0 (bit 7) No Yes No  
 

CJ1G Device Group 

General Memory Areas 
General Memory Areas for all CPUs 44 and 45. 

Prefix Start 
Channel 

End Channel Word 
Addressing 

Bit 
Addressing 

Read 
Write 

Modifiers 

IR 0 15 Yes (double) No Yes  

DR 0 15 Yes No Yes f c 

TK 0 31 Status Yes No  

A 0 447 Yes Yes No  

A 448 959 Yes Yes Yes f c 

H 0 511 Yes Yes Yes  

W 0 511 Yes Yes Yes  

CIO(opt) 0 6143 Yes Yes Yes f c 

T 0 4095 Present Value Status Yes F C 

C 0 4095 Present Value Status Yes F C 

D 0 32767 Yes No Yes  

CF 0 11 No Yes No  

CF 100 104 No Yes No  

CF 113 114 No Yes No  
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CPU 44 Memory Areas 
Memory Areas in addition to General Memory Areas. 

Prefix Start 
Channel 

End Channel Word 
Addressing 

Bit 
Addressing 

Read 
Write 

Modifiers 

E 0 32767 * 1 Yes No Yes -n 
 

CPU 45 Memory Areas 
Memory Areas in addition to General Memory Areas. 

Prefix Start 
Channel 

End Channel Word 
Addressing 

Bit 
Addressing 

Read 
Write 

Modifiers 

E 0 32767 * 3  Yes No Yes -n 

Special addresses: (all CPUs):  
(CPU 44/45):   

CLOCK, MODE.
BANKNO. 

CJ1G-H / CJ1G-H(FB) Device Group 

General Memory Areas 
General Memory Areas for all CPUs 42, 43, 44 and 45. 

Prefix Start 
Channel 

End Channel Word 
Addressing 

Bit 
Addressing 

Read 
Write 

Modifiers 

IR 0 15 Yes (double) No Yes  

DR 0 15 Yes No Yes f c 

TK 0 31 Status Yes No  

A 0 447 Yes Yes No  

A 448 959 Yes Yes Yes f  

H 0 511 Yes Yes Yes  

W 0 511 Yes Yes Yes  

CIO(opt) 0 6143 Yes Yes Yes f c 

T 0 4095 Present Value Status Yes F C 

C 0 4095 Present Value Status Yes F C 

D 0 32767 Yes No Yes  

CF 0 11 No Yes No  

CF 100 104 No Yes No  

CF 113 114 No Yes No  
 

CPU 42 Memory Areas 
Memory Areas in addition to General Memory Areas. 

Prefix Start 
Channel 

End Channel Word 
Addressing 

Bit 
Addressing 

Read 
Write 

Modifiers 

E 0 32767 * 1 Yes No Yes -n 
  

CPU 43 Memory Areas 
Memory Areas in addition to General Memory Areas. 

Prefix Start 
Channel 

End Channel Word 
Addressing 

Bit 
Addressing 

Read 
Write 

Modifiers 

E 0 32767 * 1 Yes No Yes -n 
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CPU 44 Memory Areas 
Memory Areas in addition to General Memory Areas. 

Prefix Start 
Channel 

End Channel Word 
Addressing 

Bit 
Addressing 

Read 
Write 

Modifiers 

E 0 32767 * 1 Yes No Yes -n 
  

CPU 45 Memory Areas 
Memory Areas in addition to General Memory Areas. 

Prefix Start 
Channel 

End Channel Word 
Addressing 

Bit 
Addressing 

Read 
Write 

Modifiers 

E 0 32767 * 3  Yes No Yes -n 

Special addresses: (all CPUs):  
(CPU 44/45):   

CLOCK, MODE.
BANKNO. 

    

CJ1H-H Device Group 

General Memory Areas 
General Memory Areas for CPUs 65 and 66. 

Prefix Start 
Channel 

End Channel Word 
Addressing 

Bit 
Addressing 

Read 
Write 

Modifiers 

CIO(opt) 0 6143 Yes Yes Yes fc 

DR 0 15 Yes No Yes fc 

TK 0 31 Status Yes No  

A 0 447 Yes Yes No  

A 448 959 Yes Yes Yes f 

H 0 511 Yes Yes Yes fc 

W 0 511 Yes Yes Yes  

T 0 4095 Present Value Status Yes FC 

C 0 4095 Present Value Status Yes FC 

D 0 32767 Yes No Yes  

IR 0 15 Yes (double) No Yes  

CF 0 11 No Yes No  

CF 100 104 No Yes No  

CF 113 114 No Yes No  
  

CPU 65 Memory Areas 
Memory Areas in addition to General Memory Areas 

Prefix Start 
Channel 

End Channel Word 
Addressing 

Bit 
Addressing 

Read 
Write 

Modifiers 

E 0 32767*3 Yes No Yes -n 
 

CPU 66 Memory Areas 
Memory Areas in addition to General Memory Areas 

Prefix Start 
Channel 

End Channel Word 
Addressing 

Bit 
Addressing 

Read 
Write 

Modifiers 

E 0 32767*7 Yes No Yes -n 
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CJ1M Device Group 

General Memory Areas 
General Memory Areas for all CPUs 12, 13, 22 and 23. 

Prefix Start 
Channel 

End Channel Word 
Addressing 

Bit 
Addressing 

Read 
Write 

Modifiers 

IR 0 15 Yes (double) No Yes  

DR 0 15 Yes No Yes f c 

TK 0 31 Status Yes No  

A 0 447 Yes Yes No  

A 448 959 Yes Yes Yes f  

H 0 511 Yes Yes Yes  

W 0 511 Yes Yes Yes  

CIO(opt) 0 6143 Yes Yes Yes f c 

T 0 4095 Present Value Status Yes F C 

C 0 4095 Present Value Status Yes F C 

D 0 32767 Yes No Yes  

CF 0 11 No Yes No  

CF 100 104 No Yes No  

CF 113 114 No Yes No  
 

CPM1 (CPM1A) Device Group 
Prefix Start 

Channel 
End Channel Word 

Addressing 
Bit 

Addressing 
Read 
Write 

Modifiers 

AR 0 15 Yes Yes Yes F C 

DM 0 1023 Yes No Yes  

DM 6144 6655 Yes No Yes  

HR 0 19 Yes Yes Yes F C 

IR (opt) 0 19 Yes Yes Yes F C 

IR (opt) 200 231 Yes Yes Yes F C 

LR 0 15 Yes Yes Yes F C 

SR (opt) 232 252 Yes Yes Yes F C 

TR 0 0 (bit 7) No Yes No  

TC 0 127 Present Value Status Yes F C 
 
Special addresses: MODE. 
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CPM2*/CPM2*-S* Device Group 
Prefix Start 

Channel 
End Channel Word 

Addressing 
Bit 

Addressing 
Read 
Write 

Modifiers 

AR 0 23 Yes Yes Yes F C 

DM 0 2047 Yes No Yes  

DM 6144 6599 Yes No Yes  

DM 6600 6655 Yes No No  

HR 0 19 Yes Yes Yes F C 

IR (opt) 0 49 Yes Yes Yes F C 

IR (opt) 200 227 Yes Yes Yes F C 

LR 0 15 Yes Yes Yes F C 

SR (opt) 228 252 Yes Yes Yes F C 

SR(opt) 253 255 Yes Yes No  

TR 0 0 (bit 7) No Yes No  

TC 0 127 Present Value Status Yes F C 
 
Special addresses: MODE. 

CQM1 Device Group 

Memory Areas 
Memory Areas for all CPUs. 

Prefix Start 
Channel 

End Channel Word 
Addressing 

Bit 
Addressing 

Read 
Write 

Modifiers 

AR 0 27 Yes Yes Yes F C 

DM 0 1023 Yes No Yes  

DM 6144 6655 Yes No Yes  

HR 0 99 Yes Yes Yes F C 

IR (opt) 0 243 Yes Yes Yes F C 

LR 0 63 Yes Yes Yes F C 

SR (opt) 244 252 Yes Yes Yes F C 

SR (opt) 253 255 (bit 7) Yes Yes No  

TR 0 0 (bit 7) No Yes No  

TC 0 511 Present Value Status Yes F C 

CPU 41/42/43/44/45 Memory Areas 
Memory Areas in addition to general memory areas. 

Prefix Start 
Channel 

End Channel Word 
Addressing 

Bit 
Addressing 

Read 
Write 

Modifiers 

DM 1024 6143 Yes No Yes  
 
Special addresses: CLOCK, MODE. 
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CQM1H Device Group 

Memory Areas 
Memory Areas for all CPUs. 

Prefix Start 
Channel 

End Channel Word 
Addressing 

Bit 
Addressing 

Read 
Write 

Modifiers 

AR 0 27 Yes Yes Yes F C 

HR 0 99 Yes Yes Yes F C 

IR (opt) 0 243 Yes Yes Yes F C 

LR 0 63 Yes Yes Yes F C 

SR (opt) 244 252 Yes Yes Yes F C 

SR (opt) 253 255 (bit 7) Yes Yes No  

TR 0 0 (bit 7) No Yes No  

TC 0 511 Present Value Status Yes F C 
  

CPU 11/21 Memory Areas 
Memory Areas in addition to general memory areas. 

Prefix Start 
Channel 

End Channel Word 
Addressing 

Bit 
Addressing 

Read 
Write 

Modifiers 

DM 0 3071 Yes No Yes  

DM 6144 6655 Yes No Yes  
 
Special addresses: CLOCK, MODE. 

 

CPU 51 Memory Areas 
Memory Areas in addition to general memory areas. 

Prefix Start 
Channel 

End Channel Word 
Addressing 

Bit 
Addressing 

Read 
Write 

Modifiers 

DM 0 6655 Yes No Yes  
 
Special addresses: CLOCK, MODE. 

CPU 61 Memory Areas 
Memory Areas in addition to general memory areas. 

Prefix Start 
Channel 

End Channel Word 
Addressing 

Bit 
Addressing 

Read 
Write 

Modifiers 

DM 0 6655 Yes No Yes  

EM 0 6143 * 1 Yes No Yes  
 
Special addresses: CLOCK, MODE. 
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CS1G Device Group 

General Memory Areas 
General Memory Areas for all CPUs 42, 43, 44 and 45. 

Prefix Start 
Channel 

End Channel Word 
Addressing 

Bit 
Addressing 

Read 
Write 

Modifiers 

IR 0 15 Yes (double) No Yes  

DR 0 15 Yes No Yes f c 

TK 0 31 Status Yes No  

A 0 447 Yes Yes No  

A 448 959 Yes Yes Yes f  

H 0 511 Yes Yes Yes  

W 0 511 Yes Yes Yes  

CIO(opt) 0 6143 Yes Yes Yes f c 

T 0 4095 Present Value Status Yes F C 

C 0 4095 Present Value Status Yes F C 

D 0 32767 Yes No Yes  

CF 0 11 No Yes No  

CF 100 104 No Yes No  

CF 113 114 No Yes No  

CPU 44 Memory Areas 
Memory Areas in addition to General Memory Areas. 

Prefix Start 
Channel 

End Channel Word 
Addressing 

Bit 
Addressing 

Read 
Write 

Modifiers 

E 0 32767 * 1 Yes No Yes -n 
 

CPU 45 Memory Areas 
Memory Areas in addition to General Memory Areas. 

Prefix Start 
Channel 

End Channel Word 
Addressing 

Bit 
Addressing 

Read 
Write 

Modifiers 

E 0 32767 * 3  Yes No Yes -n 

Special addresses: (all CPUs):  
(CPU 44/45):   

CLOCK, MODE.
BANKNO. 
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CS1G-H / CS1G-H(FB) Device Group 

General Memory Areas 
General Memory Areas for all CPU 42, 42, 44 and 45 

Prefix Start 
Channel 

End Channel Word 
Addressing 

Bit 
Addressing 

Read 
Write 

Modifiers 

CIO(opt) 0 6143 Yes Yes Yes fc 

DR 0 15 Yes No Yes fc 

TK 0 31 Status Yes No  

A 0 447 Yes Yes No  

A 448 959 Yes Yes Yes f 

H 0 511 Yes Yes Yes FC 

W 0 511 Yes Yes Yes  

T 0 4095 Present Value Status Yes FC 

C 0 4095 Present Value Status Yes FC 

D 0 32767 Yes No Yes  

IR 0 15 Yes (double) No Yes  

CF 0 11 No Yes No  

CF 100 104 No Yes No  

CF 113 114 No Yes No  
  

CPU 42 Memory Areas 
Memory Areas in addition to General Memory Areas 

Prefix Start 
Channel 

End Channel Word 
Addressing 

Bit 
Addressing 

Read 
Write 

Modifiers 

E 0 32767*1 Yes No Yes -n 

CPU 43 Memory Areas 
Memory Areas in addition to General Memory Areas 

Prefix Start 
Channel 

End Channel Word 
Addressing 

Bit 
Addressing 

Read 
Write 

Modifiers 

E 0 32767*1 Yes No Yes -n 

CPU 44 Memory Areas 
Memory Areas in addition to General Memory Areas 

Prefix Start 
Channel 

End Channel Word 
Addressing 

Bit 
Addressing 

Read 
Write 

Modifiers 

E 0 32767*1 Yes No Yes -n 
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CPU 45 Memory Areas 
Memory Areas in addition to General Memory Areas 

Prefix Start 
Channel 

End Channel Word 
Addressing 

Bit 
Addressing 

Read 
Write 

Modifiers 

E 0 32767*3 Yes No Yes -n 

CS1D-H Device Group 

General Memory Areas  
General Memory Areas for all CPU 65 and 67 

Prefix Start 
Channel 

End Channel Word 
Addressing 

Bit 
Addressing 

Read 
Write 

Modifiers 

CIO(opt) 0 6143 Yes Yes Yes fc 

DR 0 15 Yes No Yes fc 

TK 0 31 Status Yes No  

A 0 447 Yes Yes No  

A 448 959 Yes Yes Yes f 

H 0 511 Yes Yes Yes fc 

W 0 511 Yes Yes Yes  

T 0 4095 Present Value Status Yes FC 

C 0 4095 Present Value Status Yes FC 

D 0 32767 Yes No Yes  

IR 0 15 Yes (double) No Yes  

CF 0 11 No Yes No  

CF 100 104 No Yes No  

CF 113 114 No Yes No  

CPU 65 Memory Areas 
Memory Areas in addition to General Memory Areas 

Prefix Start 
Channel 

End Channel Word 
Addressing 

Bit 
Addressing 

Read 
Write 

Modifiers 

E 0 32767*3 Yes No Yes -n 

CPU 67 Memory Areas 
Memory Areas in addition to General Memory Areas 

Prefix Start 
Channel 

End Channel Word 
Addressing 

Bit 
Addressing 

Read 
Write 

Modifiers 

E 0 32767*13 Yes No Yes -n 
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CS1D-S Device Group 

General Memory Areas  
General Memory Areas for all CPU 42, 44, 65 and 67 

Prefix Start 
Channel 

End Channel Word 
Addressing 

Bit 
Addressing 

Read 
Write 

Modifiers 

CIO(opt) 0 6143 Yes Yes Yes fc 

DR 0 15 Yes No Yes fc 

TK 0 31 Status Yes No  

A 0 447 Yes Yes No  

A 448 959 Yes Yes Yes f 

H 0 511 Yes Yes Yes fc 

W 0 511 Yes Yes Yes  

T 0 4095 Present Value Status Yes FC 

C 0 4095 Present Value Status Yes FC 

D 0 32767 Yes No Yes  

IR 0 15 Yes (double) No Yes  

CF 0 11 No Yes No  

CF 100 104 No Yes No  

CF 113 114 No Yes No  
  

CPU 42 Memory Areas 
Memory Areas in addition to General Memory Areas 

Prefix Start 
Channel 

End Channel Word 
Addressing 

Bit 
Addressing 

Read 
Write 

Modifiers 

E 0 32767*1 Yes No Yes -n 

CPU 44 Memory Areas 
Memory Areas in addition to General Memory Areas 

Prefix Start 
Channel 

End Channel Word 
Addressing 

Bit 
Addressing 

Read 
Write 

Modifiers 

E 0 32767*3 Yes No Yes -n 

CPU 65 Memory Areas 
Memory Areas in addition to General Memory Areas 

Prefix Start 
Channel 

End Channel Word 
Addressing 

Bit 
Addressing 

Read 
Write 

Modifiers 

E 0 32767*3 Yes No Yes -n 

CPU 67 Memory Areas 
Memory Areas in addition to General Memory Areas 

Prefix Start 
Channel 

End Channel Word 
Addressing 

Bit 
Addressing 

Read 
Write 

Modifiers 

E 0 32767*13 Yes No Yes -n 
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CS1H Device Group 

General Memory Areas  
General Memory Areas for all CPUs 63, 64, 65, 66 and 67. 

Prefix Start 
Channel 

End Channel Word 
Addressing 

Bit 
Addressing 

Read 
Write 

Modifiers 

IR 0 15 Yes (double) No Yes  

DR 0 15  Yes No Yes f c 

TK 0 31 Status Yes No  

A 0 447  Yes Yes No  
A 448 959 Yes Yes Yes f  

H 0 511 Yes Yes Yes  

W 0 511 Yes Yes Yes  

CIO(opt) 0 6143 Yes Yes Yes f c 

T 0 4095 Present Value Status Yes F C 

C 0 4095 Present Value Status Yes F C 

D 0 32767  Yes No Yes  

CF 0 11 No Yes No  

CF 100 104 No Yes No  

CF 113 114 No Yes No  

CPU 64 Memory Areas  
Memory Areas in addition to General Memory Areas. 

Prefix Start 
Channel 

End Channel Word 
Addressing 

Bit 
Addressing 

Read 
Write 

Modifiers 

E 0 32767 * 1 Yes No Yes -n 

CPU 65 Memory Areas 
Memory Areas in addition to General Memory Areas. 

Prefix Start 
Channel 

End Channel Word 
Addressing 

Bit 
Addressing 

Read 
Write 

Modifiers 

E 0 32767 * 3  Yes No Yes -n 

CPU 66 Memory Areas 
Memory Areas in addition to General Memory Areas. 

Prefix Start 
Channel 

End Channel Word 
Addressing 

Bit 
Addressing 

Read 
Write 

Modifiers 

E 0 32767 * 7 Yes No Yes -n 

CPU 67 Memory Areas 
Memory Areas in addition to General Memory Areas. 

Prefix Start 
Channel 

End Channel Word 
Addressing 

Bit 
Addressing 

Read 
Write 

Modifiers 

E 0 32765 * 13  Yes No Yes -n 

Special 
addresses: 

(all CPUs):  
(CPU 64/65/66/67):   

CLOCK, MODE.
BANKNO. 
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CS1H-H / CS1H-H (FB) Device Group 

General Memory Areas 
General Memory Areas for all CPU 63, 64, 65, 66 and 67 

Prefix Start 
Channel 

End Channel Word 
Addressing 

Bit 
Addressing 

Read 
Write 

Modifiers 

CIO(opt) 0 6143 Yes Yes Yes fc 

DR 0 15 Yes No Yes fc 

TK 0 31 Status Yes No  

A 0 447 Yes Yes No  

A 448 959 Yes Yes Yes f 

H 0 511 Yes Yes Yes fc 

W 0 511 Yes Yes Yes  

T 0 4095 Present Value Status Yes FC 

C 0 4095 Present Value Status Yes FC 

D 0 32767 Yes No Yes  

IR 0 15 Yes (double) No Yes  

CF 0 11 No Yes No  

CF 100 104 No Yes No  

CF 113 114 No Yes No  
  

CPU 63 Memory Areas 
Memory Areas in addition to General Memory Areas 

Prefix Start 
Channel 

End Channel Word 
Addressing 

Bit 
Addressing 

Read 
Write 

Modifiers 

E 0 32767*1 Yes No Yes -n 
 

CPU 64 Memory Areas 
Memory Areas in addition to General Memory Areas 

Prefix Start 
Channel 

End Channel Word 
Addressing 

Bit 
Addressing 

Read 
Write 

Modifiers 

E 0 32767*1 Yes No Yes -n 
 

CPU 65 Memory Areas 
Memory Areas in addition to General Memory Areas 

Prefix Start 
Channel 

End Channel Word 
Addressing 

Bit 
Addressing 

Read 
Write 

Modifiers 

E 0 32767*3 Yes No Yes -n 
 

CPU 66 Memory Areas 
Memory Areas in addition to General Memory Areas 

Prefix Start 
Channel 

End Channel Word 
Addressing 

Bit 
Addressing 

Read 
Write 

Modifiers 

E 0 32767*7 Yes No Yes -n 
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CPU 67 Memory Areas 
Memory Areas in addition to General Memory Areas 

Prefix Start 
Channel 

End Channel Word 
Addressing 

Bit 
Addressing 

Read 
Write 

Modifiers 

E 0 32767*13 Yes No Yes -n 
 

IDSC Device Group 
Prefix Start 

Channel 
End Channel Word 

Addressing 
Bit 

Addressing 
Read 
Write 

Modifiers 

AR 0 27 Yes Yes Yes F C 

DM 0 1023 Yes No Yes  

DM 6144 6655 Yes No Yes  

HR 0 99 Yes Yes Yes F C 

IR (opt) 0 243 Yes Yes Yes F C 

LR 0 63 Yes Yes Yes F C 

SR (opt) 244 252 Yes Yes Yes F C 

SR (opt) 253 255 (bit 7) Yes Yes No  

TR 0 0 (bit 7) No Yes No  

TC 0 511 Present Value Status Yes F C 
 
Special addresses: CLOCK, MODE. 

SRM1 Device Group 
Prefix Start 

Channel 
End Channel Word 

Addressing 
Bit 

Addressing 
Read 
Write 

Modifiers 

AR 0 15 Yes Yes Yes F C 

DM 0 2047 Yes No Yes  

DM 6144 6655 Yes No Yes  

HR 0 19 Yes Yes Yes F C 

IR (opt) 0 23 Yes Yes Yes F C 

IR (opt) 200 252 Yes Yes Yes F C 

LR 0 15 Yes Yes Yes F C 

SR (opt) 232 252 Yes Yes Yes F C 

SR (opt) 253 255 (bit 7) Yes Yes No  

TR 0 0 (bit 7) No Yes No  

TC 0 127 Present Value Status Yes F C 
 
Special addresses: MODE. 
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SRM1 V2 Device Group 
Prefix Start 

Channel 
End Channel Word 

Addressing 
Bit 

Addressing 
Read 
Write 

Modifiers 

AR 0 15 Yes Yes Yes F C 

C 0 127 Yes Yes Yes F C 

DM 0 2047 Yes No Yes  

DM 6144 6655 Yes No Yes  

HR 0 19 Yes Yes Yes F C 

IR  0 23 Yes Yes Yes F C 

IR  200 239 Yes Yes Yes F C 

LR 0 15 Yes Yes Yes F C 

SR  240 253 Yes Yes Yes F C 

SR  253 254  Yes Yes No  

SR 254 255 Yes Yes No  

TR 0 0 (bit 7) No Yes No  

TC 0 127 Present Value Status Yes F C 

Special addresses: MODE. 

CV1000 Device Group 
Prefix Start 

Channel 
End Channel Word 

Addressing 
Bit 

Addressing 
Read 
Write 

Modifiers 

A 0 255 Yes Yes Yes F C 
A 256 511 Yes Yes No  

AC 0 2047 No Yes No  
C 0 1023 Present Value Status Yes F C 

CIO (opt) 0 2555 Yes Yes Yes F C 
D 0 24575 Yes No Yes  

DR 0 2 Yes No Yes  
G 0 255 Yes Yes Yes F C 
IR 0 2 Yes No Yes  
ST 0 1023 Yes Yes Yes  
T 0 1023 Present Value Status Yes F C 

TN 0 1023 No Yes Yes F C 
TR 0 0 (bit 7) No Yes Yes F C 
E 0 32765 * 2/4/8 Yes No Yes - n 

 
Special addresses: BANKNO, CLOCK, MODE. 
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CV2000 Device Group 
Prefix Start 

Channel 
End Channel Word 

Addressing 
Bit 

Addressing 
Read 
Write 

Modifiers 

A 0 255 Yes Yes Yes F C 
A 256 511 Yes Yes No  

AC 0 2047 No Yes No  
C 0 1023 Present Value Status Yes F C 

CIO (opt) 0 2555 Yes Yes Yes F C 
D 0 24575 Yes No Yes  

DR 0 2 Yes No Yes  
G 0 255 Yes Yes Yes F C 
IR 0 2 Yes No Yes  
ST 0 1023 Yes Yes Yes  
T 0 1023 Present Value Status Yes F C 

TN 0 1023 No Yes Yes F C 
TR 0 0 (bit 7) No Yes Yes F C 
E 0 32765 * 2/4/8 Yes No Yes - n 

 
Special addresses: BANKNO, CLOCK, MODE. 

CV500 Device Group 
Prefix Start 

Channel 
End Channel Word 

Addressing 
Bit 

Addressing 
Read 
Write 

Modifiers 

A 0 255 Yes Yes Yes F C 

A 256 511 Yes Yes No  

AC 0 1023 No Yes No  

C 0 511 Present Value Status Yes F C 

CIO (opt) 0 2555 Yes Yes Yes F C 

D 0 8191 Yes No Yes  

DR 0 2 Yes No Yes  

G 0 255 Yes Yes Yes F C 

IR 0 2 Yes No Yes  

ST 0 511 Yes Yes Yes F C 

T 0 511 Present Value Status Yes F C 

TN 0 511 No Yes Yes F C 

TR 0 0 (bit 7) No Yes Yes F C 
 
Special addresses: MODE, CLOCK 
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CVM1 Device Group 

General Memory Areas 
Memory Areas for any CPU. 

Prefix Start 
Channel 

End Channel Word 
Addressing 

Bit 
Addressing 

Read 
Write 

Modifiers 

A 0 255 Yes Yes Yes F C  

A 256 511 Yes Yes No  

DR 0 2 Yes No Yes  

CIO (opt) 0 2555 Yes Yes Yes F C 

G 0 255 Yes Yes Yes F C 

IR 0 2 Yes No Yes  

TR 0 0 (bit 7) No Yes Yes F C 
 

CPU 01 Memory Areas 
Memory Areas in addition to General Memory Areas. 

Prefix Start 
Channel 

End Channel Word 
Addressing 

Bit 
Addressing 

Read 
Write 

Modifiers 

C 0 511 Present Value Status Yes F C 

D 0 8191 Yes No Yes  

T 0 511 Present Value Status Yes F C 
 

CPU 11 Memory Areas 
Memory Areas in addition to General Memory Areas. 

Prefix Start 
Channel 

End Channel Word 
Addressing 

Bit 
Addressing 

Read 
Write 

Modifiers 

C 0 1023 Present Value Status Yes F C 

D 0 24575 Yes No Yes  

T 0 1023 Present Value Status Yes F C 
 
Special addresses: (all CPUs): CLOCK, MODE. 

CVM1-V2 Device Group 

General Memory Areas 
Memory Areas for any CPU. 

Prefix Start 
Channel 

End Channel Word 
Addressing 

Bit 
Addressing 

Read 
Write 

Modifiers 

A 0 255 Yes Yes Yes F C  

A 256 511 Yes Yes No  

DR 0 2 Yes No Yes  

CIO (opt) 0 2555 Yes Yes Yes F C 

G 0 255 Yes Yes Yes F C 

IR 0 2 Yes No Yes  

TR 0 0 (bit 7) No Yes Yes F C 
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CPU 01 Memory Areas 
Memory Areas in addition to General Memory Areas. 

Prefix Start 
Channel 

End Channel Word 
Addressing 

Bit 
Addressing 

Read 
Write 

Modifiers 

C 0 511 Present Value Status Yes F C 

D 0 8191 Yes No Yes  

T 0 511 Present Value Status Yes F C 
 

CPU 11 Memory Areas 
Memory Areas in addition to General Memory Areas. 

Prefix Start 
Channel 

End Channel Word 
Addressing 

Bit 
Addressing 

Read 
Write 

Modifiers 

C 0 1023 Present Value Status Yes F C 

D 0 24575 Yes No Yes  

T 0 1023 Present Value Status Yes F C 
 

CPU 21 Memory Areas 
Memory Areas in addition to General Memory Areas. 

Prefix Start 
Channel 

End Channel Word 
Addressing 

Bit 
Addressing 

Read 
Write 

Modifiers 

C 0 1023 Present Value Status Yes F C 

D 0 24575 Yes No Yes  

T 0 1023 Present Value Status Yes F C 

E 0 32765 * 2/4/8 Yes No Yes -n 

Special 
addresses: 

(all CPUs): 
(CPU 21): 

CLOCK, 
MODE. 

BANKNO. 

FinsGateway CPU Unit 
Prefix Start 

Channel 
End Channel Word 

Addressing 
Bit 

Addressing 
Read 
Write 

Modifiers 

CIO(opt) 0 32767 Yes Yes Yes  

D 0 32767 Yes No Yes  
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APPENDIX C 
Toolbars and Keyboard Shortcuts 

The following tables summarise the toolbars and keyboard shortcuts available from each component and tool. 
The F1 function key is common across all components and tools and provides context help. 

Project Editor 

Toolbar      Keyboard Shortcuts 

 

Up One Level 

Add PLC 

Add Group 

Add Point 

Cut 

Copy 

Paste 

Delete 

Rename 

Properties 

Large Icons 

Small Icons 

List 

Details 

 
Delete  Delete 
Alt+F4  Close 
Ctrl+X  Cut 
Ctrl+C  Copy 
Ctrl+V  Paste 
Ctrl+A  Select All 
F5  Refresh 
Ctrl+F  Find 
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GLOSSARY OF TERMS 
Actual IO Table The real hardware configuration of the PLC units and slots on power-up. 
Address A location in memory where data or programs are stored. It can also identify a 

location of a node on a network. 
Application A software program that accomplishes a specific task. Examples of applications are 

CX-Server, CX-Programmer, CX-Protocol and Microsoft Excel.  
Baud rate The speed of data transmission in terms of the number of bits per second that are 

being sent. 
BCD Binary Coded Decimal. 
Binary A data format supported by CX-Server. A number system format to the base 2, i.e. 

employing the digits 0 and 1. 
Bit A digit used in binary notation which can take the value 0 or 1. The value of a bit, or 

combination of bits, can represent the status of a device or can be used in 
programming. 

Bus A communications path along which data can be transmitted or received between the 
units connected to it. 

Command modifier An optional part of an address string indicating the modification to be performed on 
the data at that address (within PLC memory) when it is accessed. 

Components CX-Server is made up of six components accessible from an invoking application. 
Controller Link A network that can send and receive large data packets flexibly and easily among the 

OMRON PLCs. 
CPU type The type of CPU available to a specific device, the amount of memory available to a 

PLC varies according to the CPU involved. 
CPU Central Processing Unit. 
CVSS A file format supported by the CX-Server Import tool. CVSS has several file types 

which have different information contained in them. 
CX-Net Network Configuration tool 

This CX-Server tool consists of a suite of programs allowing the management of 
Routing Tables and Data Link Tables in OMRON PLCs. 

CX-Server  An advanced communications management system for OMRON PLCs providing 
facilities for software to maintain PLC device and address information and to 
communicate with OMRON PLCs and their supported network types. CX-Server 
supports CS1-series PLCs. 

CX-Server Project A definition of an OMRON PLC network configuration. It identifies all devices and 
networks within a particular configuration including the areas of PLC memory 
(points) that can be read from or written to. 

Data area An area of PLC memory allocated to the storage of data (not programs). 
Data bits Bits representing each character to be transmitted. 
Data link A software connection establishing common data areas between PLCs on a network 

allowing data to be between these devices. 
Data link table A table of the common data memory areas used by the PLCs in a Data Link. 
Data location An area of memory identified by an address. 
DDE  Dynamic Data Exchange. A channel through which correctly prepared programs can 

actively exchange data and control other applications within Microsoft Windows. CX-
Server, through the use of the DDE Manager tool, allows extensive use of DDE 
functionality. 

 See also Item, Server, server application and Topic. 
DDE management library A dynamic link library within Windows which allows dynamic data exchange to be 

employed. 
DDE Manager tool A CX-Server tool for transferring data between PLCs and a client application using 

DDE, for example Microsoft Excel. 
DDEML Dynamic Data Exchange Management Library. 
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Default A value automatically set by a program in the absence of user input or on initial entry 
to an application; such values can be overwritten. 

Device group A class of devices which share similar properties, each group can be sub-divided into 
device types. 

Device type A type of OMRON PLC. 
Device A type of OMRON automation device, either a PLC, Temperature Controller, 

Memory Card Writer or PROM Writer. 
Dialog A window asking for some form of response from the user, usually in the form of 

either entering requested information, selecting displayed data, or confirming an 
operation. 

DLL  Dynamic Link Library. A program file that although cannot be run stand-alone as an 
executable, can be utilised by one or more applications or programs as a common 
service. DLL files have a *.DLL extension. DLL’s comprise a number of stand-alone 
functions.  

Double Floating Point Double Floating Point (LREAL) type is as the IEEE754 Double precision (1.7E 
+308/-307) as defined by Microsoft®. 

Download Refer to Transfer to PLC. 
Drag The act of moving an item on the screen by selecting it with the mouse, and keeping 

the mouse button depressed, moving the mouse until the item has reached the required 
location. The mouse button is then released. 

Driver The software unit which controls the communications between a computer and PLC, 
translating any information passed between them into a format that the receiving 
Device can understand. 

Driver Management Tool A tool to facilitate the addition of new drivers and removal of drivers from your 
computer. 

Dynamic Data Exchange The method of transferring data (and possibly instructions) between applications via 
the establishment of reference links between them. 

EEPROM Electrically Erasable Programmable Read Only Memory. 
Elements The number of address units which start at a specified data location. 
End Connection The final communication link between computer and PLC, or in the case of a 

Network configuration, gateway PLC to PLC. 
Ethernet A 10 MB baseband local area network with each Device attached to the network 

having equal status and therefore the ability to transmit as, and when, required 
(provided the line isn’t busy). 

Even parity The number of 1s in a data transmission is even. 
Expansion memory The memory available to a CPU in addition to conventional memory. 
File memory An area of CPU memory allocated to the storage of data. 
FINS Factory Intelligent Network Service. 
FinsGateway An OMRON communication type supported by CX-Server. 
Floating Point A data format supported by CX-Server. 
Folder A structure which organises the files in computer memory or on disk. Also known as 

a ‘directory’. 
Frame length The waiting time before data is transmitted across the network 
Gateway device A Device connecting two networks of different architectures together. 
Gateway PLC A PLC which acts as a link to another network.  
Group A sub-directory within a CX-Server project hierarchy which contains points and/or 

further (subsidiary) groups. 
Hard disk A disk permanently mounted on its drive. 
Hierarchy The structure of a CX-Server project from the root directory down through any sub-

directories (groups) to individual points contained within those groups. 
Host link unit The interface between a PLC and a host computer. 
Icon Pictorial representations of computer resources and functions. Many icons are used by 

CX-Server components and tools as part of the GUI. 
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IDSC device type An OMRON PLC device supported by CX-Server. 
Import tool This CX-Server tool is used for addresses and PLCs defined using the CVSS and LSS 

products. 
Input The signal sent to a PLC from an external device. 
Instruction A statement indicating an operation to be performed and identifies any data involved 

in this operation. 
Intel Hex A PLC device also known as a PROM Writer. 
Interface Hardware or software employed to link the elements within a system, including 

networks, programs and computers. 
Internal data type The format of the data held at an address in PLC memory; for example, bit or signed 

character binary.  
Invoking application An application such as CX-Programmer and CX-Protocol that utilises components 

and tools belonging to CX-Server. 
IO Table component This CX-Server component retrieves configured PLCs rack and address data. 
IO Input /Output. 
IP address table A table containing the IP addresses for all the devices on the Ethernet. 
IP address An address for a device on the Ethernet. 
IP Internet Protocol. 
Item  A unique name for a data item within a topic. 
LAN Local Area Network. 
Link system A system that links PLCs together. 
Link unit A unit which connects a device to the network. 
Link A connection between two units established either by software or a hardware device. 
Load Placing a program or data into an area of computer or PLC memory. 
LREAL LREAL (Double Floating Point) type is as the IEEE754 Double precision (1.7E 

+308/-307) as defined by Microsoft®. 
LSS A file format supported by the CX-Server Import tool. 
Mb Megabytes – A means of defining computer memory size. 
Memory area Addressable area of storage space in a device. 
Memory Card Writer A device which writes data to a memory card. 
Memory card A data storage medium which can hold both programs and data. 
MHz Megahertz. 
Microsoft Excel A spreadsheet application. 
Microsoft Windows Explorer A file handling application part of the Microsoft Windows suite. 
Microsoft Windows A windowing environment that is noted for its GUI, and for features such as multiple 

typefaces, desk accessories (such as a clock, calculator, calendar and notepad), and 
the capability of moving text and graphics from one application to another via a 
clipboard. 

 CX-Server runs only under Microsoft Windows. DDE functions communicating with 
other applications supported by CX-Server use Microsoft Windows as a basis. 

Modem  A device with the ability to convert digital data from a computer into analogue form 
and transmit it over a telecommunications line and also to convert received analogue 
signals into digital form. 

n A variable number. 
Network Service Board An interface which connects devices (not PLCs) to the network. 
Network 1. Part of the PLC configuration, based on the device type. The number of Networks 

available is dependant on the device type. 
 2. A number of computers linked together with a central processing point known as a 

Server which is accessible to all computers. Networks affect CX-Server in that 
further Network associated options are available if the computer is Network 
connected. 
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Node number Number identifying the device located at a particular node on the network. The 
number can be between 1 and 126, the maximum number of nodes available on an 
OMRON network. 

Node A position at which a device can be located on the network, consisting of a link unit 
mounted to a device or PLC which in turn interfaces with a peripheral device or a 
computer.  

NSB Network Service Board. 
Offline The status of a device when it is not being controlled by a computer (although it may 

be physically connected to it). 
OLE Object Linking and Embedding. Used to transfer and share information between 

Microsoft Windows based applications and accessories.  
Online The status of a device when it is under the direct control of a computer. 
Output The signal sent from a PLC to an external device. 
Packet A unit of information transmitted across the network containing source and 

destination address information together with the actual data. 
Parity A type of validation check performed on transmitted information; data can be tested 

for either even, odd, none, mark or space parity. The type of parity check involved is 
indicated by the status of the parity bit. 

Path The location of a file including the drive, directory name plus any subdirectories and 
the file name together with its associated extension. 

Peripheral A device which aids system operation rather than being central to its functioning. 
Performance Monitor tool A CX-Server tool for monitoring communications throughput and for displaying CX-

Server’s current performance level (i.e. a check to see if CX-Server is becoming 
overloaded). 

Ping test  A standard Ethenet communications test. 
PLC Error component This CX-Server component displays and manages PLC errors. 
PLC Memory component This CX-Server component allows the user to view, edit and monitor either channels 

(words) or individual bits in areas of the PLC. 
PLC Setup component This CX-Server component permits the configuration of PLC settings. 
PLC Programmable Logic Controller. 
Point A point is used to hold a value of a predefined type - Boolean, Integer, Text, etc. The 

contents of a point may be controlled by an object or I/O mechanism such as DDE. 
The contents of a point may control the action or appearance of an object, or be used 
for output via an I/O mechanism. 

Port A device connection point allowing data entry and exit. 
Program A set of instructions which are performed by a computer or PLC. 
Program memory An area of PLC memory reserved for the storage of programs. 
Program mode PLC mode of operation during which the device can be programmed. 
Programmable Read Only Memory 

An area of memory which can be updated with programs and data only once after 
manufacture; once this area has been written to, it can only be read, not modified. 

Project OMRON configuration file inherited from the invoking application. 
 Refer also to CX-Server Project. 
PROM writer A device which writes the programs and data into PROM. 
PROM Programmable Read Only Memory. 
Protocol A set of rules governing the transmission of data. 
Rack  The apparatus to which a unit is fixed. 
RAM Random Access Memory. 
Registered IO Table The internal PLC table: this is the one used by the PLC when running, regardless of 

the state of the actual hardware. It can be read and, for CV-series PLCs, written to by 
the CX-Server software.  

Root The highest level of a directory. 
Root group The highest level group in a CX-Server project. 
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Rotary switch Indicates the method of calling a device by generating a series of pulses. 
Routing table A table containing the information necessary to allow communications between 

different networks including local and gateway network address details. 
Routing The direction of data across a network from its source to its destination. 
RS232 Industrial interface standard for serial communications. 
RS422 Industrial interface standard for serial communications employing balanced line 

circuits. 
Serial Connection A direct connection between computer and PLC. 
Server 1. Server is used in DDE functions to contain a link to an outside application. Using 

DDE functions, CX-Server allows the manipulation of an outside application as 
specified as the Server. 

  Refer also to Server application.  
 2. A Server is the central processing point of a Network which is accessible to all 

computers. Networks affect CX-Server in that further associated options are 
available if the computer Network is connected. 

Slots  Free areas within a rack to which units can be fixed. 
Stop bits Bits indicating the end of transmission of each set of data bits; normally one or two 

bits, they indicate the delay time between sending successive characters down the 
line. 

Symbol  An address that has been given a name to make the address information more 
flexible. Symbols are inherited by CX-Server by the invoking application. 

SYSMAC LINK OMRON high speed industrial network (either co-axial or fibre optic). 
SYSMAC NET OMRON high speed optical LAN which can be of type C SYSMAC NET or CV 

SYSMAC NET. 
SYSMAC WAY OMRON network. 
System area An area of memory used for controlling and managing a unit. 
System configuration An arrangement of units, for example network, computers and PLCs. 
Tagged database A file format supported by the CX-Server Import tool. The Tagged database is also an 

export format of the CX-Server Import tool. 
Target PLC The PLC to which information or instructions are directed. 
Taskbar An integral part of Microsoft Windows which allows Microsoft Windows based 

applications to be started. CX-Server tools are run from the Taskbar. 
TCP/IP Transmission Control Protocol/Internet Protocol. 
Temperature Controller An OMRON device. 
Temporary Relay Area An area of PLC memory containing instructions which can be loaded at a later point 

for use with other instructions. 
Text 1. A file format supported by the CX-Server Import tool. The Text is also an export 

format of the CX-Server Import tool.  
 2. A data format supported by CX-Server. 
Timer area An area of PLC memory containing program timers and their related completion 

flags. 
Toolbus A network, either C-Toolbus or CV-Toolbus, allowing communications with a device 

via the serial COM port of a personal computer (in a similar manner to SYSMAC 
WAY). Data is transmitted along the network in binary format. 

Tools CX-Server is made up of four tools. 
Transfer from PLC The transfer of a program or data to a host (either a computer or a programming 

device) from a lower-level (or slave) device. 
Transfer to PLC The transfer of a program or data from a host (either a computer or a programming 

device) to a lower-level (or slave) device. 
UDP User Datagram Protocol. 
Unit number A number identifying an individual component of an OMRON PLC system 

configuration. 
Units  A component of an OMRON PLC system configuration. 
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User Datagram Protocol Protocol which directs information across a network to port numbers rather than to IP 
addresses. 

Word  A 16 bit unit of data memory. 
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Adding a group · 12 
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Paste · 13 
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PROM Writer 
Communications · 27 

R 
Racks · 78 

S 
Slots · 79 
Special Data Types · 38 
Starting CX-Server · See access 
Status bar · 5 

Import/Export tool · 29 
Project editor · 11 

Supported Import/Export Data · 29 
Symbols · 79 
SYSMAC LINK 

Communications · 17, 26 

Network settings · 26 
SYSMAC NET 

Communications · 17, 26 
Network settings · 26 

SYSMAC WAY 
Communications · 16, 19 
Modem communications · 16, 19 
Network settings · 19 

System requirements · 2 

T 
Technical Specification · 1 
Toolbars and Keyboard Shortcuts · 73 
Toolbus 

Communications · 16, 19 
Modem communications · 16 
Network settings · 19 

U 
Units · 79 

W 
Words · 80 

 



 

 

 


	CHAPTER 1�Technical Specification
	CX-Server Software
	About this Manual
	Features
	System Requirements
	Communications Requirements
	Installation
	Starting CX-Server
	Help and How to Access it
	Help Topics
	Index
	Find
	Context-sensitive Help
	About CX-Server
	Status Bar


	Technical Support

	CHAPTER 2�Introduction to CX-Server Projects
	CX-Server Projects
	CX-Server Project Concepts
	PLCs
	Points

	Editing a CX-Server Project PLC List
	Adding a PLC
	Deleting a PLC
	Renaming a PLC

	Editing CX-Server Project
	Adding a Group
	Renaming a Group
	Adding a Point
	Editing a Point
	Deleting a Point or Group
	Moving and Copying Points and Groups
	Adding a Device


	CHAPTER 3�Communications
	Supported Communications
	Device Setup
	PLC Settings
	Device Type Settings

	Defining Connections and Gateway PLCs
	Serial Communications (Direct Connection)
	SYSMAC WAY
	Toolbus
	Serial Networks

	Network Communications (End Connection)
	DeviceNet
	SYSMAC LINK
	SYSMAC NET
	Controller Link
	Ethernet
	PROM Writer


	CHAPTER 4�Import/Export Tool
	Supported Import/Export Data
	CX-Server Project Selection
	Import
	Importing from CVSS
	Importing from LSS
	Importing from Text Files
	Importing from FinsServer

	Export
	Exporting Data to Text Files
	Exporting Data to FinsServer Files


	CHAPTER 5�DDE Manager Tool
	Establishing DDE Links
	Defining a Link
	Service
	Topic
	Item

	Copying a Point
	Automatic versus Manual Updates
	Automatic Updates
	Manual Updates


	Defining Update Intervals
	Special Data Types

	CHAPTER 6�Performance Monitor Tool
	C
	CHAPTER 7�Driver Management Tool
	APPENDIX A�Network Availability
	C**H Device Group
	C**K Device Group

	A
	APPENDIX B�PLC Memory Areas
	C**H Device Group
	C**K Device Group
	General Memory Areas
	CPU 32/42 Memory Areas
	General Memory Areas
	CPU 32/42 Device Group
	CPU 65 Memory Areas
	CPU 85 Memory Areas
	General Memory Areas
	CPU 44 Memory Areas
	CPU 45 Memory Areas
	General Memory Areas
	CPU 42 Memory Areas
	CPU 43 Memory Areas
	CPU 44 Memory Areas
	CPU 45 Memory Areas
	General Memory Areas
	CPU 65 Memory Areas
	CPU 66 Memory Areas
	General Memory Areas
	Memory Areas
	CPU 41/42/43/44/45 Memory Areas
	Memory Areas
	CPU 11/21 Memory Areas
	CPU 51 Memory Areas
	CPU 61 Memory Areas
	General Memory Areas
	CPU 44 Memory Areas
	CPU 45 Memory Areas
	General Memory Areas
	CPU 42 Memory Areas
	CPU 43 Memory Areas
	CPU 44 Memory Areas
	CPU 45 Memory Areas
	General Memory Areas
	CPU 65 Memory Areas
	CPU 67 Memory Areas
	General Memory Areas
	CPU 42 Memory Areas
	CPU 44 Memory Areas
	CPU 65 Memory Areas
	CPU 67 Memory Areas
	General Memory Areas
	CPU 64 Memory Areas
	CPU 65 Memory Areas
	CPU 66 Memory Areas
	CPU 67 Memory Areas
	General Memory Areas
	CPU 63 Memory Areas
	CPU 64 Memory Areas
	CPU 65 Memory Areas
	CPU 66 Memory Areas
	CPU 67 Memory Areas
	General Memory Areas
	CPU 01 Memory Areas
	CPU 11 Memory Areas
	General Memory Areas
	CPU 01 Memory Areas
	CPU 11 Memory Areas
	CPU 21 Memory Areas


	APPENDIX C�Toolbars and Keyboard Shortcuts
	Project Editor
	Toolbar						Keyboard Shortcuts


	GLOSSARY OF TERMS

